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Introduction 
 

In today’s digitally interconnected yet socially fragmented world, youth work faces an 

increasingly complex set of challenges. Hate speech, racism and disinformation have 

found fertile ground in both online and offline spaces, influencing how young people 

perceive themselves, others and the world around them. At the same time, young people 

are also among the most agile digital users - with immense potential to become critical 

thinkers, creative storytellers and active agents of 

change. This set of methodological guidelines has 

been developed in response to this context, 

aiming to empower youth workers and educators 

with the tools, strategies and conceptual 

frameworks to navigate these issues through the 

lens of media literacy and participatory practice. 

HATE-LESS project methodological guidelines 

are part of a broader project involving six 

European partners, each contributing expertise in 

youth participation, education, media and social 

justice. The project's overarching goal is to 

strengthen the role of media literacy in combating 

hate speech, disinformation and racism, while 

promoting inclusive, youth-led approaches to 

storytelling and civic engagement. 

 

The objectives of the project are: 

● To combat hate speech and disinformation via media literacy to counter fake news 

and advocate for diverse migration narratives. 

● To enhance media and digital literacy in youth work, empowering youth to critically 

analyse hate speech and disinformation. 

● To mobilise youth workers and organisations for inclusive societies through 

participatory methods and technology. 

● To strengthen social and civic competencies by promoting fundamental values, 

mutual respect, intercultural dialogue and combating discrimination. 

These guidelines are designed to equip youth workers with practical, creative and forward-

thinking methods that enhance inclusive storytelling and support anti-racism efforts through 

digital tools. In today’s social world, youth work is a platform for empowerment, building 

identities and promoting social transformation. Hence, the need for innovative practices is 

regarded as a matter of relevance. Innovation in youth work is not only about adopting the 

latest technology for the sake of novelty, it’s about finding meaningful, accessible and 

culturally sensitive ways to connect with young people and amplify their voices. Methods 

such as storyboarding, autoethnography and soundscape creation offer powerful entry 

points for participants to reflect on personal experiences, explore shared struggles and 

narrate their own truths. These guidelines reflect this vision by combining theory, practice 
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and reflection into an accessible and modular format designed for direct use in youth work 

settings.  

The methodological guidelines represent a comprehensive educational and practical 

resource designed to support youth workers, educators and trainers in implementing 

inclusive, technology-enhanced participatory practices aimed at countering hate speech 

and disinformation. With the use of these resources, youth can create, hear and see 

realities that challenge current beliefs and promote a stronger sense of community. 

One of the core premises of this guidelines is that media literacy is not just a skill set - it is 

a form of critical empowerment. Through a deeper understanding of how media narratives 

shape perceptions of race, migration and identity, youth workers can support young people 

in becoming more discerning consumers and producers of content. By fostering reflection 

on bias, power and representation, media literacy becomes a tool for inclusion, resilience 

and democratic participation. Each chapter in the guidelines focuses on a different 

dimension of this work, combining conceptual insight with hands-on methodologies: 

● Chapter 1 introduces participatory actions. These frameworks center young people 

as equal co-creators of knowledge and highlight the value of collective agency, 

empowerment and inclusion. 

● Chapter 2 focuses on how to deconstruct hate speech and disinformation, offering 

reflective methods and strategies to help youth critically engage with biased or 

manipulative narratives. It emphasizes resilience-building through education, 

dialogue, and counter-narratives. 

● Chapter 3 serves as a practical guide to conducting Participatory Action Research 

(PAR) with young people. It outlines a step-by-step approach to engaging youth in 
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meaningful, ethical inquiry through tools such as empathy maps, interviews and 

storytelling of significant change. 

● Chapter 4 presents a range of creative and digital tools - such as storyboards, 

soundscapes and autoethnography - used to promote inclusive storytelling. It offers 

guidance on how youth workers can implement these methods to foster anti-racism, 

participation and active citizenship. The chapter also lays the groundwork for 

participatory video creation in later stages. 

● Chapter 5 is a technical guide that walks youth workers through the process of 

producing participatory videos - from planning and storyboarding to filming, editing 

and publishing. This chapter includes tips on engaging youth in collaborative visual 

storytelling while ensuring ethical and inclusive practices. 

● Chapter 6 wraps up the guidelines by focusing on training and facilitation. It offers 

suggestions on how to translate the methodologies into applicable training formats, 

build the capacities of youth workers and create ripple effects through multiplier 

activities and follow-up actions with youth participants. 

An Annex offers a list of materials and digital tools recommended by participants during 

project focus groups. This resource pool reflects the lived experience and digital realities 

of the target audience, making the methods more relevant and adaptable. 

An analysis of the structure and content highlights several key areas of focus: 

1. Youth Engagement through Participatory Actions and Approaches 

(Chapters 1, 3, 6) 

The project is grounded in a philosophy of active youth involvement at every stage - from 

planning and research to content creation. Participation is combined with democratic 

education and empowerment-oriented approaches. 

2. Analysing and Deconstructing Hate Speech and Disinformation (Chapter 2) 

Hate speech is understood not only as something to be countered, but as a symptom of 

broader socio-cultural issues that can be addressed through participation and education. 

3. Media Literacy and Innovative Practices (Chapter 4) 

This chapter serves as a bridge between theory and practice. Technology is presented not 

merely as a tool, but as a means of fostering critical thinking, media competence and 

agency. 

4. Technical Support for Participatory Video (Chapter 5) 

This is one of the most valuable chapters for the practical implementation of media projects 

with youth. 

5. The Role of the Youth Worker (Throughout the Chapters) 

The final chapter emphasises the importance of the training component, which 

complements the methodological guidance with practical exercises. 

General Conclusion 

The methodological guidelines create a holistic ecosystem of learning, co-creation and 

transformation.  

 

 

  



 

 

P
a

g
e
7

 

Chapter 1: Participatory 
Approaches in Youth Work 

 

This chapter explores Participatory Action as a transformative approach in youth work, 

with a focus on media-based practices in the context of rising online hate speech, 

discrimination and racism. By engaging young people as equal partners in the co-creation 

of knowledge and storytelling, participatory action empowers them to critically reflect on 

their realities and actively shape their communities. Participatory methods offer youth 

workers a powerful framework to foster inclusion, amplify marginalized voices and promote 

civic engagement through collaborative media production. 

 

1.1 Why Participatory Action? 
Participatory Action Research (PAR) is a research-to-action approach. It converges 

knowledge and experiential learning with a call to action, co-collaboration and change. 

According to Cornish et. al., PAR is “an approach to research that prioritizes the value of 

experiential knowledge for tackling problems caused by unequal and harmful social 

systems, and for envisioning and implementing alternatives.” Further descriptions and 

definitions of key terms are provided in Chapter 2, but to offer some introductory context: 

PAR is an important contribution to youth work, especially in times of social transformation. 

The method, while centering on participation, enables passive recipients to become active 

co-creators. Paulo Freire, a Brazilian educator and philosopher who was well-known for 

his contribution to PAR theory, criticized traditional education as a “banking model,” where 

teachers deposit information into passive students. His view was that this approach 

dehumanized learners, discouraged critical thinking and reinforced oppressive structures. 

Freire instead proposed a “problem-posing model” of education grounded in dialogue, 

mutual respect and co-creation of knowledge. In this model, teachers and learners engage 

as equals, both teaching and learning from one another, and education becomes a practice 

of freedom. Through dialogue that combines reflection and action (praxis), young people 

gain the ability to critically question their world and actively transform it. Freire saw this as 

the first step toward empowerment and liberation, especially for those in marginalized or 

oppressed positions. This framework underpins participatory methods like PAR, where 

youth are not passive recipients of support, but active agents shaping their learning and 

their communities. 

Key principles of PAR: 

● Dialogue as love, humility and trust. 

● Education rooted in learners’ real experiences. 

● Thematic investigation: uncovering and exploring the problems youth face in their 

own lives. 

● Collective knowledge creation: no hierarchy but shared discovery. 

Taking into consideration the importance of PAR, the United Nations Children's Fund 

(UNICEF) provides a Guide for Adolescent Participation and acknowledges “participation 



 

 

P
a

g
e
8

 

as a fundamental human right.” 

Link: Guidance on Child and Adolescent Participation as part of Phase III of the preparatory 

action for a European Child Guarantee Version 1.0 (December 2021)  

 

1.2 Co-Creation and Collaboration with Youth 
(Non-formal) youth education faces particular challenges in the context of the use and 

reception of social media and real social experiences against the backdrop of numerous 

ethnic, social and political lines of conflict. In view of growing internal tensions in European 

democracies, the search for ‘identity’ is becoming increasingly important. According to 

Lucius-Höhne's definition, "identity describes the way in which people perceive and 

understand themselves based on their biographical development (biography) in constant 

interaction with their social environment. Important factors that contribute to the constitution 

of one's own identity include gender, age and social background, ethnicity, nationality and 

group affiliations, occupation and social status, but also personal characteristics and skills." 

Identity development is a lifelong process of learning and adapting to changing life 

circumstances, with the youth phase being particularly important because this is when 

significant influences on one's value system are formed.  

This is precisely where projects such as Hate-Less must come in, so that the formation of 

value constructs is supported that contribute to personality development based on one's 

own strengths and not on the aggressive exclusion of “others”. It is therefore necessary 

that the young people in the target group of the Hate-Less project are treated with respect, 

are heard and are involved in the project work on an equal footing. The main goal here is 

to convey that developing one's own positive identity is authentic, while disparaging other 

social groups leads to the opposite development. 

 

https://www.unicef.org/eca/media/19426/file/Child%20and%20Adolescent%20Participation%20in%20the%20CG
https://www.unicef.org/eca/media/19426/file/Child%20and%20Adolescent%20Participation%20in%20the%20CG
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1.3 Inclusion and Empowerment Through PAR & 
Media Work  
The increasing importance of digital influences requires not only working with media, but 

also organising real encounters in order to open up a personal, real space for experience. 

This is all the more true as media work usually yields the best results when done as a team. 

A good film requires a well-functioning team in front of the camera and microphone, 

working closely with the team members responsible for the technology and the smooth 

running of the production. Media work as teamwork is therefore not only a valuable tool for 

practising respectful interaction, but the result (film/audio) is only convincing if all team 

members are deployed according to their skills and knowledge. This also makes it clear 

that a wide range of qualifications and skills at different levels are necessary for the 

success of the media project. The spectrum ranges from planning skills, for example in 

concept and script development, location scouts, media law knowledge, acting skills in 

front of the camera, a good eye for images and technical understanding in the field of 

camera and sound technology to complex skills in the field of post-production.  

During and after completion of production, social media and PR measures for the finished 

media products are also required. This simultaneously sharpens the technical and 

conceptual skills required for their use. 

Another significant effect of such projects is that the project participants enter into 

processes of mutual learning and usually pass on their own knowledge about specific parts 

of the project to other group members. The realisation of a media project is therefore also 

a multidimensional learning project on a number of different levels. 

However, media work - as envisaged in the Hate-Less project - offers further great 

opportunities for imparting values. Identity-forming processes are triggered by the media 

treatment of a social or more private problem area, the questioning of opinions 

disseminated in the media or personally, etc. and the need to build a successful media 

project on fact-based or emotionally comprehensible authenticity. The positive effects are 

based on one's own (team) performance and not on negative differentiation from others 

(groups). 

Media work therefore not only offers the opportunity for personal development, but also 

encourages reflection on one's own actions and the examination of one's own 

(pre)judgments. After all, at the end of the project, it is necessary to present the results to 

an external audience.  

At the same time, media work offers the opportunity to support the mostly young project 

group members on an equal footing in terms of content and technology. Responsibility for 

the final media product will lie primarily with the young producers during the conceptual 

practical phase of the Hate-Less project. Media work in the sense described above is 

therefore also democratic work. It teaches basic skills in research, exposing fake news and 

democratic coordination of work steps within the team. 

After the successful completion of a media project, there is often a change in perspective 

regarding one's own media use and reflection on the content received. Active media project 

work thus offers a great opportunity for all participants to learn how to deal with media 

constructively and to open up a broad field for critical thinking in the media world. 
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In summary: 

● Media work is a form of social intervention and expression. 

● Participatory media fosters identity, voice and agency, ensuring accessibility and 

inclusive practices for marginalized youth (e.g., linguistic, cognitive, physical, etc.) 

 

1.4 Practical Application: From participatory 
learning process to implementation  
There are many ways to apply participatory action and Participatory Action Research 

(PAR) within youth work, particularly through creative and collaborative methods. Young 

people thrive in environments where they can explore relevant topics collectively, drawing 

on their own experiences and perspectives. Co-creating knowledge through methods such 

as storytelling, community mapping, role-play, and digital platforms enables youth not only 

to engage with complex issues but also to develop critical thinking and social awareness. 

Youth-led productions, such as participatory video projects, campaigns or podcasts, serve 

as powerful tools for self-expression and community impact. In this process, the role of the 

facilitator shifts from instructor to collaborative guide, ensuring that decision-making is 

shared and inclusive. This fosters a sense of ownership, responsibility and agency among 

young participants, making the learning process both meaningful and action-oriented.  

1.4.1 Examples of Co-Creation and Peer-led Media Work 
An illustrative example of participatory media work can be found in the 

Bundesfreiwilligendienst (BFD) programme at the 

Bennohaus in Münster, Germany. Each year, 

young people aged 17-24 take part in a 

voluntary service that functions as a 

transitional and orientation phase 

before entering higher education or 

vocational training. Within this 

framework, volunteers become 

integral members of the team, 

gaining access to professional 

media training and technical 

equipment, and are encouraged 

to explore societal topics 

through creative media 

production. 

Co-creation is not merely 

encouraged but embedded in 

the structure: volunteers work 

collaboratively on multimedia 

formats taking collective 

responsibility for concept, 

production and dissemination. Topics are introduced by staff, yet interpretation, tone and 

format are shaped by the volunteers themselves. The peer-to-peer learning dynamic 
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unfolds organically, as each individual brings unique skills and perspectives, enriching the 

team’s process through shared discovery and dialogue. The low-threshold hierarchy 

enables trainers to act as companions rather than instructors - advising when needed, 

while respecting and learning from the volunteers’ voices. Through this model, young 

participants not only develop technical competencies but also engage in value-oriented 

reflection, take ownership of their media narratives and cultivate interpersonal skills such 

as conflict resolution and collaborative decision-making. The result is a deep sense of 

responsibility for their work and a strengthened belief in their own agency - a lived 

experience of participation, self-efficacy and democratic practice. 

BFD Video Projects:  

“Peace Chain” between Münster and Osnabrück: 

https://www.youtube.com/watch?v=RXx3H8NPl1E&t=49s  

Quarter to East - Children on Social Media & LWL Art Museum: 

https://www.youtube.com/watch?v=-sfoE5HMg-4  
 

1.4.2 Reflecting on Participatory Themes 
Participatory Action fosters a profound sense of empowerment and ownership among 

young people by positioning them as active contributors to decision-making processes. It 

challenges traditional hierarchies within educational and social structures, emphasizing 

horizontal collaboration, collective responsibility and equitable power-sharing. Through the 

collective engagement in participatory projects, such as the Hate-Less initiative, youth are 

enabled to develop context-specific, anti-discrimination guidelines and codes of conduct, 

directly addressing issues of exclusion and injustice within their communities. This 

approach is inherently rooted in democratic principles and participatory ethics, making it a 

powerful tool for promoting inclusion and social justice. Therefore, PAR reinforces the 

importance of diversity sensitivity and critical agency.   

Reflective practices such as journaling, group storytelling, narrative documentation and 

feedback loops support both youth and facilitators in examining their roles, learning from 

experience and reinforcing the impact of their actions. By embedding reflective practices, 

both participants and facilitators are encouraged to critically engage with their experiences 

and continuously adapt their strategies. In doing so, participatory action not only 

contributes to personal and collective transformation but also equips young people to 

become effective agents of social change, particularly in efforts to counter hate speech, 

discrimination and systemic inequality. In principle, these approaches prepare youth for 

civic engagement and leadership.  

Reflection Question: “How do you currently involve youth in decision-making? What 

would need to change for youth to become co-creators in your context?” 

 

  

https://www.youtube.com/watch?v=RXx3H8NPl1E&t=49s
https://www.youtube.com/watch?v=-sfoE5HMg-4
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Chapter 2. Why 
Deconstructing Hate Speech 
and Disinformation Matter 

 

In recent years, the internet has become both a platform for open dialogue and a breeding 

ground for hate speech and disinformation. The rapid growth of digital communication, 

while offering unprecedented access to information and connection, has also made it 

easier for harmful narratives to spread widely and instantly. Young people, who spend a 

significant part of their lives online, are particularly exposed to these influences. As they 

navigate digital spaces to form their views about society, identity and politics, they become 

both the targets and potential vectors of manipulative content. 

 

The increasing normalisation of online hate, alongside the sophistication of disinformation 

tactics, poses a direct challenge to democratic societies. These phenomena erode trust, 

fuel polarisation and undermine critical thinking. In this context, education becomes not 

only a matter of knowledge transfer but a vital tool for equipping the next generation with 

the skills to identify, resist and counteract these threats. By fostering media literacy, 

empathy and a culture of respectful dialogue, we strengthen democratic resilience and help 

young people reclaim their agency in shaping the digital spaces they inhabit. 

Deconstructing hate speech and disinformation is therefore not only a defensive strategy 

but a proactive investment in a more inclusive, informed and democratic future. 

 

2.1 Core Concepts and Definitions 
To build a solid foundation for understanding how participatory actions can address hate 

speech and disinformation, it is essential first to clarify the key concepts involved. These 

concepts are interrelated yet distinct, each playing a crucial role in shaping the social and 

digital landscape that young people navigate today. 

Hate Speech refers to expressions, gestures or conduct that demean, threaten or incite 

violence against individuals or groups based on attributes such as race, ethnicity, religion, 

gender, sexual orientation or other identity markers. Hate speech is not merely offensive 

language; it is a form of communication that undermines the dignity and safety of targeted 

communities. It can foster division and hostility, often escalating into real-world 

discrimination or violence. Understanding hate speech is critical because it challenges the 

principles of equality, respect and human rights at the heart of democratic societies. 

Closely linked to hate speech are the phenomena of disinformation and misinformation. 

Disinformation is the deliberate creation and sharing of false or misleading information 

intended to deceive an audience. It often serves political, economic or ideological goals 

and can be spread by various actors, including foreign entities seeking to influence 

democratic processes. Misinformation, on the other hand, consists of false information 



 

 

P
a

g
e
1

3
 

shared without harmful intent, often due to ignorance or error. Both disinformation and 

misinformation contribute to confusion, mistrust and polarization, undermining public 

debate and the informed decision-making that democracy depends on. 

Critical Thinking emerges as a vital skill in this context. It involves the ability to analyse 

and evaluate information objectively, questioning assumptions and recognizing biases. 

Critical thinking enables individuals to discern fact from falsehood, to appreciate nuance 

and to resist manipulation. Developing critical thinking goes beyond acquiring knowledge; 

it requires cultivating a mindset of curiosity, reflection and skepticism towards simplistic 

narratives, especially in the fast-paced and often emotionally charged world of online 

communication. 

Participatory Action represents a methodology and philosophy inclusive of those affected 

by social issues through the process of understanding and changing their realities. 

Specifically, Participatory Action Communication (PAC) is a practice that encourages 

communities, particularly young people, to become active agents in creating media and 

narratives that reflect their experiences and perspectives. PAC challenges traditional, top-

down approaches to education and communication by fostering dialogue, collaboration and 

empowerment. By engaging participants directly in media production, PAC nurtures critical 

awareness, collective reflection and agency - essential tools for resisting hate speech and 

disinformation. 

Together, these core concepts provide the intellectual framework for the participatory 

approaches explored in this chapter. They reveal how communication practices, social 

dynamics and educational strategies intersect in the ongoing effort to build resilient, 

democratic communities in the face of growing online hostility and manipulation. 

 

2.2 Intersections and Entanglements 
Understanding how hate speech and disinformation are intertwined requires a grasp of 

their combined effects. Each one feeds the other, and together they thrive in climates of 

algorithmic amplification and low levels of critical literacy. Both hate speech and 

disinformation depend on emotions that give them legitimacy and earned attention. 

The veracity of misleading content plays on a level of fear, anger and/or distrust. This is 

the kind of strategy the European Parliament calls, "playing on emotions." In practice, this 

could mean a post that suggests immigrants are "stealing jobs," or that some targeted 

social group threatens public safety. This framing can lead to visceral reactions that push 

readers to accept false premises or share content without considering its validity.  

Additionally, there is a relationship in the intentional amplification of disinformation or 

hateful narratives in digital ecosystems. This often manifests as an information overload - 

half-truths or speculations pushed into the information space over and over across media 

and social media alike, leaving users disoriented and confused. Flooding the information 

space distorts the reasons people respond in ways that are not based on mutual interest. 

Hate-laden disinformation can then be distributed as floods of indistinguishable quotes or 

imagery depicting targeted communities as dangerous or threatening to the social order, 

which accelerates social polarisation and makes a coherent, public response difficult. 

This kind of manipulation is also further amplified when engaging with confirmation bias. 

Audiences will tend to consume and share content that reinforces what they already 
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believe. Hate-driven or misleading content can find willing listeners and promoters among 

users that  hold prejudice or irrational projected beliefs when circulated uncritically. This 

reiterates the European Parliament’s observation of exploiting confirmation bias; 

misinformation feeds fears or stereotypes while hate speech fuels emotional investment 

and group divisions. 

 

Efforts to decontextualize or distort quotes, speeches or statistics pave another bridge 

between hate discourse and disinformation. The European Parliament highlights how 

“manipulating context” is being used to mislead audiences with cherry-picked or wrongly 

framed snippets. For example, a statement advocating humane immigration policy may be 

edited to seem as though it praises criminals at the country’s expense. Such distortion 

creates false narratives that feed both distrust and hatred. By framing issues like migration, 

gender equality or religious expression as zero-sum games between “us” and “them,” 

disinformation amplifies social division, reinforces group bias and transmits hate speech 

into the mainstream. Finally, a strategy frequently overlaps both: targeted assaults on 

individuals or institutions that challenge normative narratives. Disinformation campaigns 

can tar journalists, activists and community leaders in the context of conspiracies, foreign 

influence or financial impropriety/fraud. These assaults serve to de-legitimize specifically 

valid criticism and reinforce hateful stereotypes. In digital spaces, all of these tactics are 

interdependent. Algorithms favoring hyper-engagement, often emotional or sensational 

engagement, no matter the truth of the content, help explain this interdependency. Hate 

becomes the vehicle for disinformation and vice versa. Critical thinking and dialogue 

remain, perhaps, the only intervention to confront these decoupled dynamics. Key 

interventions that people themselves can incorporate into their daily lives include media 

literacy skills, self-awareness of your own biases and the use of spaces fostering respectful 

dialogue. 

By understanding how hate speech and disinformation intersect through tactics, such as 

emotional manipulation, context manipulation, flooding, confirmation bias, polarisation and 

targeted attacks, we will be able to better devise interventions as educators and youth 

workers. 

 

2.3 Participatory Action as a Methodology to 
Counter Hate 
Participatory methodologies, in particular Participatory Action Communication (PAC), can 

provide a robust approach to countering hate speech and disinformation. The principal 

premise of PAC is that the people most impacted by an issue should play a key role in 

understanding and changing it. In PAC, young people do not consume pre-packaged 

messages; rather, they become active contributors and help create narratives of their own 

that relate to their lived experiences. 

PAC puts youth in a position of power by transitioning from being receivers of information 

to being the storytellers. In PAC context, it is not just about critiquing existing media but 

about creating content. This can be youth-produced media, community awareness 

campaigns or simply a short narrative video. In doing so, youth reflect critically, express 
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directly and build an awareness of agency, which in turn fosters resilience and self-

expression. 

There are not only researchers and educators claiming this approach is effective. Funding 

for training programs supported by the European Commission are also recognizing the 

value of media literacy in combatting online hate and 

disinformation (highlighted in national reforms like 

Germany’s NetzDG and BZKJ frameworks). In these 

contexts, youth are encouraged to not only 

deconstruct harmful messages but to also help 

produce creative counter-narratives which are 

grounded in their local reality - the ideal of 

PAC. 

At the European level, media literacy 

initiatives by both the Council of Europe 

and the European Digital Media 

Observatory explain that developing 

cognitive and analytic skills provides 

learners with the tools to locate and critique 

manipulative content - whether it is categorically hateful 

or factually false. Participatory video, in particular, allows 

participants to critique their media ecosystems, while also 

developing a sense of collective responsibility. This twin 

capacity, to gain critical consciousness regarding media 

structures as well as to physically create their own counter material, is what gives PAC its 

impetus and what makes it a method of active resistance. 

The literature on critical youth engagement tells us that youth are more motivated to be 

civically engaged if they are involved in the research process, with youth organizing their 

own inquiry, reflection and collective action - all of which are central to Participatory Action 

Research (PAR) as a method. In anti-hate contexts, PA-based activities allow youth to 

make visible the micro-aggressions, coded language and sources of misinformation, and 

eventually, to compose shared messages and measures with empathy and social 

cohesion. Youth will gain some sense of resilience and ownership in these processes; they 

are not just being ‘protected’ against hate but are empowered to transform hate. 

This distinction between passive reception and active engagement shifts how young 

people begin to think of themselves in relation to democratic life. Through making their own 

stories, young people begin to understand that their own voices matter. They understand 

participation democratically is not only considered abstractly but also existentially, 

relational, and in media. In a sense, PAC can be employed as both a method to deconstruct 

harmful speech and put in place a measure for a stronger and better conversation that is 

more inclusive for the public sphere. 

 

2.4 Practical Reflective Tools and Exercises 
PAR and PAC become most potent, not only in intention, but in action. Bringing 

participatory values into the everyday realities of schooling and education allows young 
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people to recognize and resist the hate speech and disinformation inside their own 

contexts. This section foregrounds one way that students' reflective activities which take 

place in classrooms or youth groups can become support structures for thinking critically 

and developing democratic resilience in youth; and, they do not require pricey resources 

or expert knowledge. 

One of the easiest entry points to PA practice is media reflection journalism - a form of a 

reflective journaling where students keep a regular log of online content (i.e., memes, 

videos, comments and articles) that they feel emotionally impacted by. Instead of making 

the emotional response the subject of the journal, they are encouraged to write on what 

they saw, how they felt about it and how they may have experienced that emotion. Over 

time through regular journaling, students begin to see patterns emerge regarding the 

emotional techniques used in these manipulative pieces of media as outlined in institutional 

resources of disinformation: over-simplified viewpoints, appeals to emotions (feeling sad, 

loyal, outraged, etc.), scapegoating (us vs. them), and so on. This experience is gradual 

and repetitive, resulting in an intrinsic filter, based not on distrust but awareness. 

Dialogue-based analysis could be a super useful way to consider whether examples of 

online speech (anonymized or fictionalised) might be deemed hate speech or 

disinformation in a small group setting. Drawing on the speech, people work together to 

think through the language used - potential intentions of the language - and whether 

someone or group was affected by it. The task here is not to arrive at one "right" way of 

interpreting speech but to develop skills useful for asking the right questions. Narrative 

rewriting can also offer a practical way to engage. Students take existing hostile or 

misleading messages and rewrite them with empathy, complexity or factual nuance. A 

headline that scapegoats a minority can be reconstructed with broader context. A viral 

conspiracy theory can be broken down and presented as a timeline showing how it spread 

and who benefits. This exercise reinforces both the power and responsibility of storytelling. 

These education tactics highlight that being resilient is not about sheltering young people 

from false or hateful messages but preparing them to confront and make sense of the 

issue(s). The participatory methods - whether role-playing debates, producing podcasts or 

creating short video essays - invite participants to challenge public opinions within a society 

while thinking about how others may perceive and counter those messages. 

These are not just tools for "raising awareness," they also build analytical muscles. By 

collectively creating, deconstructing and discussing messages, youth envision themselves 

as performers in the media landscape. This shapes their collective power to question 

language, to respond and reject suggestive and/or aggressive speech. 

 

2.5 Final Takeaways and Next Steps for Youth 
Workers 
When working with young people on hate speech and disinformation, one-off workshops 

or theoretical explanations are not enough. The best way to contribute to positive outcomes 

- by way of agency, reflective practices and dialogue - is to create opportunities for 

continued engagement as part of an ongoing process. The PAC approach is a commitment 

to active agency, not passive reception. It is crucial to engage in ongoing opportunities for 
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involvement with young people to build resilient democratic societies. 

Today’s youth occupy multifaceted roles as media producers, influencers, interpreters and 

amplifiers. However, when their media engagement remains critically unexamined, there 

is a risk that they may inadvertently reproduce the same dynamics of exclusion and division 

that are frequently highlighted in EU institutional reports. The challenge lies in the fact that 

even youth-led, co-creative projects can unconsciously reinforce dominant societal 

narratives or mask exclusionary practices in more subtle and insidious ways. Yet, the 

cultural and political relevance of young people is undeniable. In the context of rapid social 

transformation, youth are not merely adapting to existing systems - they are reshaping the 

landscape of public discourse, asserting new forms of power, voice and agency. When 

equipped with the analytical tools to deconstruct dominant media narratives and the 

creative means to reconstruct them, young people are uniquely positioned to contribute to 

a more inclusive and equitable public sphere; or, conversely, to replicate harmful 

paradigms. The PA approach recognizes this dual potential and intentionally creates 

process-oriented spaces in which young people can not only critique hostile or 

exclusionary texts but also formulate and disseminate meaningful counter-narratives.  

In terms of implementing this into educational practice, this does not necessitate moving 

the entirety of the educational system away from exam-driven pedagogy and youth 

programs or  from structured to more fluid systems. It does require commitment from 

educatorsand youth facilitators who are prepared to allow their students to explore their 

own reflective and collective practices. This can range from student video or podcast 

production around social issues, moderated discussions about current events or even 

campaigns in the classroom around digital media. How they explore this represents the 

final layer, which must include discourse, dialogue and co-creation. 

A recurring message from European Parliament and Commission initiatives is that 

democratic resilience cannot be built by only identifying threats (or harmful content). It has 

to be practiced through democratic participation. When learners are asked to think 

critically, to speak from their own experiences and to challenge what they see online, they 

become more than informed, they become engaged. The next step for youth workers is 

not to aim for perfection but to start somewhere. Small, consistent efforts to bring PAC into 

the classroom can gradually change how young people see media, interact with difference 

and respond to manipulation. Over time, these practices become habits, and those habits 

become the backbone of a more resilient civic culture. In a time when digital platforms are 

saturated with emotionally charged and misleading narratives - particularly targeting young 

people - education must go beyond cultivating awareness. It must employ empathy, 

resilience and active resistance. Participatory action can be a meaningful, practical 

response.  

For youth workers, the message is clear: meaningful engagement matters more than 

exposure to facts alone. When young people have space to reflect, express and co-create, 

they are far better equipped to resist manipulation and reject hateful narratives. Embedding 

participatory methods in everyday practice is not a luxury; it is an urgent, practical step 

toward safeguarding democracy, social cohesion and informed public discourse. 
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Chapter 3. How to Do 
Participatory Research with 
Youth 

 

Participatory Action Research (PAR) is best considered as an approach to research rather 

than a research method. It is done with or by the people who participate, rather than on, 

about or to them. Grounded in the rights-based approach of ‘nothing about us, without us,’ 

PAR aims to disrupt power imbalances. This means it is especially useful when researching 

with young people who are marginalised within their communities, such as young people 

living in poverty, young people with migrant background, young people who experience 

online and/or onsite bullying or ‘mobbing,’ children and youth not in school, and any other 

groups who may be vulnerable and often left on the margins of research endeavors. When 

used effectively, PAR can support youth agency and activism by promoting inclusion as 

well as help to unearth key themes affecting young people or solutions to help them thrive, 

which would have otherwise remained hidden. 

In PAR, adults typically partner with young people to identify questions to study, provide 

them with training in research methods, support them in conducting research and facilitate 

them using their knowledge, experience and research findings to inform positive change 

on issues relevant to their lives. Authentic power-sharing between adult facilitators and 

youth researchers is a cornerstone of PAR. This represents a major shift in how adults and 

youth typically interact. PAR also offers opportunities for youth to use their research 

findings and lived experiences to provide input on their schools and communities. 

This chapter offers youth workers a practical, step-by-step guide for designing and 

facilitating inclusive, youth-led research processes. It introduces accessible tools such as 

empathy maps, interviews and the “stories of most significant change” to help young people 

explore and express their lived experiences. The Hate-Less Guidelines intend to support 

youth workers, youth trainers, youth program coordinators, educators or social workers to 

effectively work together with young people to plan a research project on issues relevant 

to their lives which belong to the main themes of the HATE-LESS project (i.e., media 

awareness, hate speech, disinformation, fake news and how these affect the lived 

experiences of young people). The chapter emphasizes ethical considerations, sensitivity 

in facilitation and reflective practice, ensuring that research is both empowering and 

respectful. It supports youth workers in guiding young people through collaborative 

planning, data collection and analysis, enabling them to shape narratives that directly 

reflect their perspectives and realities. 

 

3.1 Step-by-Step Guidance 
Intentional design of a PAR project helps to ensure that both youth and adult partners 

maximize the benefit of engaging in this work and that the action from PAR projects create 
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meaningful change in the world. It also helps to ensure that we continue to build the body 

of knowledge and corroboration of the participatory action approach. As we are more 

intentional about the design of PAR projects, we can better capture the impact and 

outcomes of this important work.  

The following identifies the 5 key steps to ensuring meaningful participatory research with 

young people: 

3.1.1 Define Purpose and Research Questions 
Young people bring invaluable insights when they take on the role of co-researchers, 

helping to shape both the focus and goals of a participatory study. Involving them early on 

ensures that the research addresses topics they find important. By consulting youth from 

the start, adult facilitators gain a deeper understanding of the issues at stake and can 

confirm that the chosen methods and expected outcomes resonate with participants’ real 

concerns.  

Adult researchers should be 

thoughtful in determining which 

young people to include. It’s important 

to avoid bias - for example, favoring 

young people with more advanced 

education and English language 

skills. Make strategic efforts to 

include vulnerable young people 

(e.g.,  those who may be 

marginalised due to poverty, 

disability, gender, ethnicity 

or other intersectional 

barriers) through financial 

and non-financial support 

to ensure that their 

experiences directly inform 

the research objectives and 

agenda-setting process. 

To uncover research topics, 

facilitators can use open-ended 

approaches: invite youth to 

describe what “community” means to them and to highlight strengths worth reinforcing and 

challenges they wish to address. Depending on participants’ experience, this exploration 

might be a broad discussion of impressions or a more targeted activity such as interviewing 

key individuals or running small surveys.  

Key steps include: 

a. Co-identify risks, problems, vulnerabilities and deprivations that young people encounter 

in their everyday lives.  

b. Prioritise these issues in order of severity or significance to the co- researchers. 

c. Answer basic research questions using the "5W1H" method: ‘What?’ ‘Who?’ ‘When?’ 

‘Where?’ ‘Why?’ and ‘How?’ 

Example questions: 
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WHAT? - What are the changes we ultimately want to achieve? What are the broad 

questions we want to answer? What information do we need to understand the 

issues at hand? 

WHO? - Who is involved? Who has power to support these changes? Who are allies 

on this issue? 

WHEN? - When did the subject of events occur? When to address the issues or 

under what timeline? 

WHERE? - Where did the subject of events take place? Where will the results of 

the research be displayed?  

WHY? - Why is the topic important, and why will a certain line of research be useful 

in contributing to change in our community? 

HOW? - How will the information we obtain be used? 

If we want to contextualise this to the scope and themes of the HATE-LESS project, we 

can ask: “What kinds of misleading narratives do young people encounter most often in 

our community?” “Why do these narratives persist, and how do they influence attitudes or 

behaviors?” “Who holds influence or power to address these harmful narratives - peers, 

educators, platform moderators, local organizations?” and “How can the findings be used 

to reshape media literacy initiatives or inform community actions against hate speech?” By 

co-creating questions in this way, youth develop critical thinking and research skills, and 

the study remains focused on actionable outcomes. This collaborative definition of purpose 

and inquiry paves the way for ethical, impactful participatory research that empowers 

young people to drive change in media practices and social inclusion. 

Before moving on to the next stage, check that you have: 

 ✓ Clearly stated why participatory research is needed and what you hope to achieve. 

 ✓ Engaged youth in identifying issues relevant to their lives and communities. 

 ✓ Used an inclusive and intersectional approach to involving youth researchers with 

familiar and accessible technologies and materials. 

 ✓ Used an inclusive approach to identifying the research goals. 

 ✓ Developed and finalised clear research questions. 

 ✓ Set out a well-defined purpose underlying the research questions - clearly stating why 

the particular approach you’re taking is necessary. 

 ✓ Made sure that none of the participants’ ideas or inputs were overlooked. 

 ✓ Clarified that the discussion is intended to guide the next steps of the research project. 

3.1.2. Plan and Design Research Tools 
Participatory action research demands that young people are included meaningfully in the 

research design process. For this reason, adult facilitators need to ensure that their 

younger co- researchers have the context and vocabulary to shape that design, alongside 

their more experienced collaborators. Adult researchers should begin this stage by carrying 

out a needs assessment to find out what their younger co-researchers know (if anything) 

about research approaches. They can then identify their co-researchers’ strengths and 

where they may need support to develop their knowledge of collaborative research 

approaches. 

When we develop the research tools, we need to keep in mind both young participants and 
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a young audience. Adults should consult with their co-researchers about themes and tools 

that are accessible to young people who haven’t had any formal training in research design. 

Approaches can be wide-ranging, but typically involve a mix of audio and visual tools such 

as mapping exercises, focus groups, observations and small-scale surveys. 

Key steps include: 

a. Decide what kind of data you need: 

Is there already some useful data that the team can analyse together? Or do the 

researchers need to generate their own new data? 

b. Identify interviewees: 

Where and when will the research take place? Who should we talk to and why?   

c. Choose a research method: 

What types of information or insights are needed?  

What are the constraints we need to be aware of? For example: budget, timeframe, cultural 

sensitivities or political sensitivities.  

What sorts of research methods can help us to generate that information or those insights? 

For example: perceptions or prevalence statistics and trends over time. 

d. Discuss the relative strengths and weaknesses of potential research methods. 

There are quite a lot of promising practices that can be used to collect data or simply tell 

one’s own story, and you can find a number of those in Chapter 4; however, a significant 

tool can be that of ‘Photovoice.’ As a PA research method, photovoice gives young 

researchers a chance to think about and express their priorities within the context of a 

participatory action research project. By using audio-visual technology they are already 

familiar with, young co-researchers can help children and adults to see the world through 

their eyes, in a way that many participants feel is more familiar than traditional media. 

Photovoice can also be used in a variety of ways, to document daily life, or take 

photographs that represent the issues that are important to young people by simply 

developing captions for their photographs to explain the context to their audience and 

peers. 

Using online research tools allows participants to take part, according to their own 

situation, and within any time and space constraints they face. Popular online tools 

include: 

● Virtual community mapping. 

● Group discussions (both within communities and where language capacities 

permit across international contexts). 

● Audio journaling (this is useful not only for conducting PAR in which researchers 

document their own experiences, but it can also be used as a means of self-

reflection and assessment by participants in PAR projects). 

● Arts-based participatory research (such as hip-hop-based research) allows 

participants to reflect on their social identities within society. You can see the 

example of the following song that was developed in the context of the Horizon2020 

project “NEW ABC - Networking the Educational World: Across Boundaries for 

Community-building” https://www.youtube.com/watch?v=RxZVXyxzd8Q  

Other examples of research tools designed and tailored for young people include: 

 

https://www.youtube.com/watch?v=RxZVXyxzd8Q
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Tool/Method Purpose/Use Case 

 

Empathy Maps Explore feelings, perceptions and 

experiences of youth or their peers 

Peer Interviews Enable youth to collect data from peers, 

increasing trust and authenticity 

Stories of Most Significant Change Gather narratives about impactful 

experiences or changes 

Community/Body Mapping Visualize environments, relationships and 

lived experiences 

Focus Groups Facilitate group reflection and collective 

analysis 

Social Network Mapping Understand community connections and 

influences 

Timeline/Life-Course Mapping Reflect on personal and collective 

journeys and milestones 

 

Before moving on to the next stage, check that you have: 

 ✓ Identified useful types of data. 

 ✓ Developed tools and exercises to make the research aims clear for co-researchers. 

 ✓ Gathered feedback from all participatory researchers to identify strengths and 

weaknesses of each potential approach. 

 ✓ Ensured that all researchers understand and are comfortable with the scope and 

content of subject matter being investigated on an ongoing basis. 

 ✓ Co-created a research plan with youth, ensuring shared decision-making. 

 ✓ Selected or adapted tools for youth-friendly data collection.     

3.1.3. Collect Data Collaboratively 
After you have co-created the research design and methodology with young researchers, 

the data collection process can begin. Again, you should enable young people to lead 

during this stage. Peer-to-peer interviewing, a qualitative participatory method where youth 

researchers design, collect and report on interviews held with other young people, is one 

approach that enables young people to lead and allows us to get to the heart of issues 

young people face. It puts young people center stage in collecting primary data but also 

makes the most of their unique access to their own communities. Peer interviews are a 

valuable tool for accessing ‘hidden’ populations - young people who may be harder to reach 

and less responsive to adult researchers’ questions. 

Key steps include: 

a. Ensure every participant has an equal opportunity to contribute. Since not every young 
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researcher feels at ease with the same approaches, offer diverse tools and methods so 

that everyone’s perspective can be captured. 

b. Recognize and address any power differences between adults and youth. Actively invite 

young people to voice their suggestions and priorities regarding both the study focus and 

how data are gathered. 

c. Protect young researchers as they work within their communities. Because they may be 

exposed to risks tied to their backgrounds or identities, develop a clear safety plan, 

identifying referral points or support services, to keep them secure throughout the research 

process. 

d. Leverage young researchers’ insider knowledge of their communities. Encourage them 

to conduct interviews among peers and across generations, tapping into their unique 

access to gather deeper, more meaningful insights. 

Before moving on to the next stage, check that you have: 

 ✓ Confirmed that every participant had an equal opportunity to engage while 

accommodating different roles and responsibilities and striving for balanced involvement. 

 ✓ Embedded skill-building opportunities within the data collection phase so that young 

researchers can gain specific competencies that help them gather high-quality data. 

 ✓ Employed multiple data collection techniques that leverage the unique abilities and 

perspectives of all members of the research team. 

 ✓ Made sure co-researchers understand and practice reflexivity, reflecting on how their 

own perspectives may influence the research. 

3.1.4. Analyze and Interpret Data 
To do participatory research well, participants should be involved in and/or lead in 

analysing and interpreting the data collected. Data analysis and interpretation is a critical 

stage, as it helps to ensure that research findings accurately reflect participants’ 

perspectives. Once data has been collected, analysis and interpretation can be a lengthy 

process that presents an imposition on young people’s daily lives and responsibilities, and 

so this needs to be carefully negotiated and planned, including options for more or less in-

depth involvement of youth researchers from the outset. Young researchers’ capacities are 

also a factor in their ability to participate in data analysis and interpretation - or at least in 

adult researchers’ decision to include them. This should ideally be addressed during the 

capacity, strengthening element of the research design stage. 

Key steps include: 

a. Involving youth in coding, categorizing and interpreting data.  

b. Agreeing on a systematic way to arrange the material gathered, including transcripts, 

photographs, observational notes or additional non-textual data.  

c. Using visual models to identify themes. 

d. Reflecting on positionality and intersectionality, ensuring diverse perspectives are 

considered. 

Before moving on to the next stage, check that you have: 

 ✓ Collated and organised all data sources, whether text- or image-based. 

 ✓ Used a consistent methodology to categorise data points. 

 ✓ Developed a model, visual or otherwise, to display emerging themes. 
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 ✓ Considered how data will be stored and managed safely. 

3.1.5. Share Findings in Youth-Friendly Ways 
Keeping young people closely involved at this stage is really valuable because it maximises 

the benefit of the research to young people and promotes their ownership not just over the 

process, but the outcomes. 

Key steps include:  

a. Share research findings to encourage others to engage with those findings. 

● Produce materials that are translated into the language(s) used by participants, so 

that they can use those resources in their own work within their communities. 

● Make findings more accessible to young people by providing summaries, alongside 

visuals that can be readily showcased and replicated. 

● Use videos that are conducive to social media platforms such as Instagram and 

TikTok. 

● Make sure to have safeguarding procedures in place for young people to feel safe 

and represented in both online and in-person events. 

b. Take action and advocate for change 

 

Before moving on to the next stage, check that you have: 

 ✓ Identified the change young people want to see and used this for developing strategies 

for dissemination. 

✓ Collaborated with co-researchers so that they have been able to develop ownership over 

how and where they share their results. 

✓ Facilitate youth-led advocacy and follow-up actions. 

 

3.2 Ethics, Facilitation, and Sensitive Topics 
Effective participatory research with youth requires careful attention to ethical 

considerations, facilitation strategies and the handling of sensitive content. Below is an 

expanded discussion organized into key areas. This guidance can serve as a stand-alone 

one-page reference to help youth workers, facilitators and co-researchers navigate 

complex issues responsibly and inclusively. 

3.2.1 Equity and Power Sharing 
At the core of ethical participatory research is treating young people as equal partners 

rather than passive subjects. From the outset, involve youth in decision-making about 

research design, methods, and how findings will be used or shared. Co-create roles and 

responsibilities together: ask youth what tasks they want to lead (e.g., designing interview 

questions, facilitating focus groups, analyzing data, etc.) and where they prefer to 

contribute as team members. Explicitly discuss power dynamics: acknowledge that adult 

facilitators hold institutional authority and may influence decisions and invite youth to speak 

up if they feel their voices are overshadowed. Establish ground rules collaboratively - such 

as rotating facilitation, shared agenda-setting and consensus-based decision-making - to 

ensure that all perspectives are respected. By embedding equity in every step, the 

research environment becomes more transparent, trustworthy and reflective of 

participants’ real interests. 
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3.2.2. Informed Consent and Safeguarding 
Safeguarding youth participants is paramount. Before any activity begins, provide clear, 

age-appropriate explanations of the research purpose, processes and potential risks or 

benefits. Obtain informed consent from youth (and, where required, from parents or 

guardians) by sharing written or verbal information in accessible language. Emphasize that 

participation is voluntary and that they can withdraw at any time without penalty. Discuss 

confidentiality measures: explain how data (notes, recordings, images) will be stored, who 

will access it and how anonymity or pseudonyms will be used, if needed. Anticipate 

potential risks (e.g., emotional distress, privacy concerns or unintended disclosures) and 

develop a safeguarding plan. Identify referral services (counselors, support hotlines, 

trusted adults) and procedures if a participant discloses sensitive issues (e.g., harm or 

discrimination). Train all facilitators and co-researchers on these protocols, so they can 

respond promptly and appropriately. 

3.2.3. Compensation and Accessibility 
Meaningful participation often requires time, effort and resources from youth. Allocate a 

portion of the project budget for fair compensation - this might include vouchers, stipends 

or covering transport and refreshments - ensuring that no young person is excluded due 

to financial constraints. Clearly communicate compensation policies at the start, so youth 

understand how and when they will be reimbursed. Equally important is addressing 

accessibility: choose meeting locations (physical or online) that accommodate diverse 

needs (e.g., mobility, hearing, vision, language). Provide materials in multiple formats 

(large print, audio, translated summaries) and allow flexible scheduling or asynchronous 

participation options when possible. Proactively ask youth about any special requirements 

(e.g., assistive technologies, quiet spaces, childcare) and incorporate their suggestions. 

Prioritizing these elements promotes inclusivity and signals respect for each participant’s 

circumstances. 

3.2.4. Dealing with Sensitive Topics 
Participatory research often explores challenging issues - inequality, discrimination, mental 

health or trauma - that can evoke strong emotions. Prepare youth researchers through 

orientation sessions: discuss potential emotional triggers and set expectations about the 

content they may encounter. Offer guidelines for self-care and mutual support, such as 

taking breaks, using check-ins at the start and end of sessions and encouraging peer 

listening. During data collection or analysis, monitor participants’ well-being. If distress 

arises, pause activities and provide immediate support or referrals as outlined in the 

safeguarding plan.  

After sensitive sessions, schedule debriefing opportunities - individual or group - where 

youth can reflect on their feelings, share coping strategies and suggest adjustments for 

future activities. Facilitators should model empathy, active listening and non-judgmental 

responses. By anticipating and planning for emotional challenges, the research remains 

respectful and supportive of youth well-being. 

3.2.5. Reflexivity 
Ongoing reflection is crucial for ethical rigor. Encourage both adult facilitators and youth 

co-researchers to examine their own assumptions, biases and positions of privilege. 

Integrate brief reflexive exercises - such as journaling prompts, group reflections or “check-

in” discussions - at regular intervals. Questions might include: “How might my background 
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influence how I interpret these findings?” or “Whose voices are we hearing most, and who 

might be missing?”  

Documenting reflexive insights helps the team adjust methods or outreach to ensure 

diverse perspectives are included. Facilitation should remain flexible: if reflections reveal 

power imbalances or blind spots, revisit roles or adapt strategies. By embedding reflexivity 

throughout the process, the research stays ethically grounded, transparent and responsive 

to emerging challenges. 

3.2.6 Facilitation Tips 
✓ Start by building trust through a brief icebreaker or sharing session. 

✓ Create and agree on team norms together so everyone feels safe. 

✓ Use arts-based or interactive activities to keep sessions engaging. 

✓ Rotate between discussion, drawing, role-play or digital tools to include diverse learners. 

✓ Be clear about who does what and how decisions are made. 

✓ Explain roles and expectations at the start of each activity. 

✓ Offer short training segments on new methods before practice. 

✓ Pair youth with mentors or co-facilitators so they can learn by doing. 

✓ Gradually hand over leadership tasks to youth as they grow more confident. 

✓ Check in regularly on how youth feel about their responsibilities. 

✓ Give positive feedback and celebrate small wins after each milestone. 

✓ Acknowledge contributions publicly (e.g., in a group chat or brief announcement). 

✓ Encourage youth to suggest improvements and adapt methods as you go. 

✓ Use accessible language and visuals so everyone understands. 

✓ Provide quick how-to guides or cheat-sheets for digital tools. 

✓ Plan short breaks and informal check-ins to maintain energy. 

✓ Remind participants that making mistakes is part of learning. 

✓ Close sessions by reflecting on what worked well and what to try next. 

In summary, this chapter underscores participatory research as a rights-based, 

collaborative approach that positions young people as co-researchers rather than subjects, 

fostering agency and unearthing insights that might otherwise remain hidden. By outlining 

five key stages -from defining purpose and co-creating research questions, through tool 

design, collaborative data collection, joint analysis and youth-friendly dissemination - the 

chapter provides youth workers and facilitators with a clear roadmap for meaningful 

engagement. Emphasis on inclusivity and intersectionality ensures that diverse voices, 

especially those of marginalised youth, inform each step. 

Ethical considerations, facilitation strategies and reflexive practice permeate the guidance, 

highlighting the importance of power-sharing, informed consent, safeguarding and support 

when addressing sensitive topics. By building trust, offering hands-on training, and 

gradually shifting leadership to young researchers, facilitators create learning 

environments where participants develop critical skills and ownership over outcomes. 

Ultimately, this approach not only strengthens research quality and relevance but also 

empowers youth to drive positive change in their communities. 
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Chapter 4. Innovative 
Practices and Digital Tools 

 

This part of the methodological guidelines serves as an active instrument for social 

cohesion, empathy and resistance through practical and innovative tools.  

 

4.1 Key Challenges and Opportunities 
There are several challenges in integrating media literacy into youth work. One major issue 

is the growing "neo-illiteracy", a term Tapio Varis (2004) uses to describe the gap between 

people who have access to media but lack the critical skills to interpret it. This can lead to 

the spread of misinformation and the reinforcement of harmful stereotypes (Varis, 2004). 

Another challenge is the simplification of digital literacy to mere technical know-how. José 

Manuel Pérez (2004) argues that digital literacy should not be reduced to using devices. 

Instead, it should be seen as a holistic process involving emotional, cognitive and practical 

competencies (Pérez 2004). This comprehensive view opens up more meaningful ways to 

engage youth. 

 

On the other hand, there are great opportunities. The shift from an industrial society to an 

information society brings new possibilities for youth engagement. When supported by 

media-literate youth workers, young individuals can tell their own stories, reflect on their 

identities and advocate for justice. Moreover, the multicultural nature of today’s world calls 

for media literacy that values diversity and inclusion. Youth work that embraces media 

literacy can become a space where different voices are heard, respected and empowered. 

By developing both critical and creative abilities, young people are better equipped to 

navigate the digital world and shape the society they live in. 

 

4.2 Approaches to Inclusive Storytelling 
4.2.1 Principles of Anti-Racist and Inclusive Storytelling 
When young people from diverse backgrounds are encouraged to tell their stories using 

methods that center their lived experiences, it validates their identities and also challenges 

systems of inequality and bias. In this situation, storytelling turns into a tool for speaking 

out against discrimination, ending silence and fostering understanding among people of 

different backgrounds. By combining creative approaches with innovative digital tools, this 

guide aims to support youth workers in designing workshops and interventions that are 

engaging, inclusive and grounded in the realities of the communities they serve. It offers a 

set of methods and a mindset that embraces experimentation, emphasizes equity and 

believes in the transformative power of story. 

According to Ladzekpo, Amekor, and Davi (2024), storytelling is an effective technique for 

influencing attitudes, establishing empathy and creating inclusive societies. When utilized 

purposefully, it may dispel negative perceptions and provide voice to those who are 
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frequently disadvantaged or ignored. By acknowledging the diversity of human experience, 

inclusive storytelling makes sure that tales represent a broad spectrum of identities, 

cultures and viewpoints. 

 

At the heart of anti-racist storytelling is intentionality, the deliberate choice to represent 

people fairly and respectfully, while acknowledging and addressing power imbalances and 

histories of oppression (Morettini, Abraham, and Wilson-Hill, 2022). This means moving 

away from stories that portray marginalized communities only through trauma or struggle, 

and instead sharing stories that also highlight joy, resilience, creativity and everyday life. 

 

Curfman (2021) claims that inclusive storytelling offers "windows, mirrors and sliding glass 

doors." People may see into other people's lives (windows), consider their own experiences 

(mirrors) and enter other people's viewpoints (doors). These metaphors remind us that 

storytelling must be accessible and meaningful to all, not just those who have traditionally 

or historically controlled the narrative. 

 

To make storytelling inclusive and anti-racist, youth workers and facilitators must: 

● Encourage co-creation, rather than speaking for others. 

● Respect cultural ownership of stories. 

● Challenge biases in language, visuals and framing. 

● Provide context that helps audiences understand the systemic issues behind 

personal experiences. 

Furthermore, freedom should be at the heart of inclusive storytelling; it's not enough to only 

convey tales about disadvantaged people, we must also empower young storytellers to 

share their own experiences in their own words. 
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4.3 Creative Methods for Storytelling 
According to Heinemeyer (2020), storytelling becomes more powerful when it is supported 

by creative, participatory methods that allow young people to express themselves in 

diverse and meaningful ways. These methods are not just tools for communication, they 

are also approaches that encourage critical reflection, cultural awareness and emotional 

engagement. Among the most effective storytelling methods are storyboards, 

autoethnography and soundscapes. Each of these offers unique possibilities and suits 

different contexts. Storyboards, for instance, are visual plans that help structure narratives 

before producing videos or animations. They are especially helpful in group settings where 

planning and collaboration are needed, and they work well with participants who feel more 

comfortable sketching or organizing ideas visually. 

 

Autoethnography, on the other hand, invites individuals to use their personal experiences 

as a starting point for storytelling and analysis. It is deeply reflective and ideal for personal 

growth, identity exploration and exploring connections between self and society.  

 

Soundscapes use ambient sound, voice and music to evoke emotion and place, offering 

an accessible, non-visual medium that engages the senses and includes those who might 

struggle with writing or drawing. 

 

Every approach has advantages and disadvantages. Autoethnography is insightful but 

emotionally draining, storyboards are extremely organized but can hinder spontaneity and 

soundscapes are immersive but may need technical assistance or supervision to create 

(Mou, Jeng, and Chen, 2013; Winkler, 2018; Rajguru, Obrist, and Memoli, 2020).  The 

secret is to adapt the approach to the participants' requirements, abilities and situation. 

Ultimately, these methods can be combined or adapted to fit different goals. Used 

thoughtfully, they empower young people to craft authentic stories, build media skills and 

participate actively in shaping narratives that reflect their lived realities. 

4.3.1 Storyboards 
Storyboards are a sequence of drawings or frames that visually outline a story or concept 

before it's turned into a video, animation or presentation (Hart 2013). Each frame typically 

includes images, short text or notes about actions, emotions and transitions. In youth work, 

storyboards are used to help young people organize their thoughts, plan their narratives 

and collaborate on creative projects (Kuczynska, Goncalves, and Guerri, 2019). They act 

as visual scripts that clarify ideas, ensure inclusive participation and provide a safe 

structure for exploring sensitive topics such as identity, discrimination and inclusion. 

 

Using storyboards allows youth to brainstorm and co-create stories that reflect their 

experiences and viewpoints. Because they are visual, they also help reduce language 

barriers, making them especially useful in multicultural or multilingual groups. Youth 

workers can use storyboards to guide discussions on anti-racism, anti-discrimination, 

stereotypes and empathy through diverse representations. 
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4.3.2 Steps to Create an Inclusive Storyboard 
 

Step Title Visual Guide / Notes 

1       Define the Theme: Begin by 

discussing the central message or 

issue, e.g., a personal experience 

with discrimination or a vision of a 

more inclusive community. 

 

     Choose a topic (e.g., exclusion, 

justice, community). 

   Discuss: “What message do we 

want to share?” 

2            Break the Story into Scenes: 

Identify key moments, emotions 

or turning points. Discuss how 

each part connects to the larger 

message. 

 

   Identify story beats: 

- Beginning (Setup) 

- Middle (Conflict) 

- End (Change) 

🗺 Use a 3-6 box storyboard layout. 

3      Draw or Describe the Scenes: 

Participants sketch, collage or 

describe what happens in each 

frame, using visuals or simple 

notes. 

      Sketch or write each scene. 

🖼 Use drawings, magazine clippings 

or written notes. 

         One scene per frame. 

4                                                   Include Diverse Perspectives: 

Make sure all voices are heard. 

Encourage youth to include 

multiple characters or viewpoints 

to reflect real-life diversity. 

 

   Encourage multiple 

characters/views. 

🗣 Ask: “Whose voices are missing?” 

   Show diversity in age, culture, 

gender, abilities, etc. 

5    Discuss and Reflect: Talk 

about the choices made, what’s 

being shown, who is represented 

and how. Is the story fair, 

inclusive and respectful? 

 

    Talk through scenes: 

- Are they respectful? 

- Who is included? 

- What emotions are shown? 

   Prompt: “How does this story 

make people feel?” 

6     Revise as Needed: Allow 

space for feedback and changes. 

Inclusion often means rethinking 

parts of the story to better reflect 

shared values. 

 

      Get feedback from peers. 

              Edit images or scenes for clarity. 

    Check: Does it align with 

inclusion and fairness values? 
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Sample Storyboard Template (A Six-Box Grid with six boxes, ideal for short stories or first-

time users). Others include; 

● Scene-by-Scene Layout: A more detailed version with space for notes on camera 

angles, dialogue and sound. 

● Character Journey Board: Focuses on one character’s development and 

perspective, useful for exploring identity and growth. 

Youth workers can adapt these templates to fit the group’s needs, ensuring the process 

remains accessible, inclusive and engaging for all participants. 

4.3.3 Autoethnography 
Autoethnography is a form of self-reflective storytelling which invites young people to write 

about their own life experiences and link those stories to culture or community (Harrison et 

al., 2022; Rodriguez, 2024). According to Harrison et al. (2022), in practice this process 

“unites autobiography (telling one’s life) and ethnography (studying culture).” In youth 

programs, teachers explain that autoethnography makes use of each student’s unique 

background, languages and traditions as strengths in the narrative. By focusing on 

personal memories or family history, students see how their identity (family, culture, race, 

etc.) has helped shape their story and how it connects to larger social themes. 

4.3.4 Promoting Identity and Voice 
● First-person voice: Autoethnography gives youth the chance to speak in their own 

voice. Students write in the first person (“I”) about themselves, literally centering 

their personal perspective (Harrison et al. (2022). This validates their experience 

and helps them feel heard. 
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● Exploring identity: It encourages reflection on who they are. For example, a student 

might write about a family tradition or a school event and then ask themselves, 

“What does this memory tell me about my heritage or values?” This process turns 

private experiences into stories of identity. 

● Counter-narratives: Sharing personal stories can challenge stereotypes. In research 

on marginalized students, autoethnographic “counter-stories” have helped shift 

views from seeing students as having deficits to seeing them as carrying strengths 

and knowledge (Martin and Garza, 2020). In other words, youth become recognized 

as experts of their own lives, and their stories add new perspectives to classrooms 

and communities. 

4.3.5 Structuring an Autoethnographic Narrative 
● Start with a vivid episode: Choose an important event or moment (often called an 

“epiphany”) that had a big impact on you (Tyner-Mullings, 2019). It could be anything 

from a family celebration, a personal challenge or a turning point in your life. 

● Tell it like a story: Describe the scene in detail, who was there, what happened and 

how you felt. Use sensory details (sights, sounds, feelings) to make the memory 

come alive. Writing it like a narrative (with a beginning, middle, and end) helps 

readers follow along. 

● Reflect on meaning: After narrating the event, add a reflection. Explain why this 

moment mattered: How did it change you or teach you something? What did you 

learn about yourself, your culture, or the world? This part connects the personal 

story to bigger ideas. 

● Connect to culture or community: Think about how your story ties to your cultural or 

family background. You might compare your experience to others’ or explain 

traditions. For example, “Growing up, my family told a lot of stories about our 

ancestors. Recording my own story adds another chapter to our family history.” 

● Use creative elements if you like: Autoethnography can include dialogue (maybe 

quotes from family members) or even non-traditional forms (a poem or letter) as 

long as it comes from your real experience. The key is honesty and insight. 

Listeners/readers should learn something about your identity or culture. 

4.3.6 Reflective Questions for Youth 
● What is a memorable event from your life (at home, school, or elsewhere) that 

helped shape who you are? Describe it and why it mattered. 

● Can you think of a family story or tradition you love? Write it down and explain what 

it tells you about your background or values. 

● Recall a time when you felt different from others (for example, because of your race, 

language, beliefs, or abilities). What happened, and how did that experience affect 

how you see yourself? 

● Has there been a moment when someone misunderstood you or made an 

assumption about you? How did that feel, and what would you like them to know 

about you instead? 

● Imagine your life as a movie. What would be a key scene (with sound and setting) 

that really shows who you are or where you come from? Describe that scene in 

detail. 
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4.3.7 Soundscapes 
A soundscape narrative is an audio story created by arranging recorded sounds instead of 

just words or pictures. Students can layer environmental sounds, music and voice 

recordings to paint an auditory picture of a place or story (Miller, 2020). For example, one 

exercise asks learners to arrange layers of sound to convey a sense of place and story 

(Miller, 2020). You might record birdsong, footsteps and wind to tell the story of a walk in 

the woods, or mix school bell chimes and playground laughter to evoke a day at school - 

all without showing any images. 

4.3.8 Inclusive Audio Storytelling 
Audio-based projects are very inclusive. They let young people tell their stories using their 

own voices and sounds, which can be easier for those who struggle with writing or have 

different language skills. Anyone can speak, sing, hum or record everyday sounds. 

Classrooms use audio to bring out diverse perspectives: for instance, an “Inclusion” 

storytelling project had students produce short podcast episodes about experiences of 

belonging, encouraging each student’s personal voice in the narrative (Inclusive Schools 

Network, 2025). Likewise, digital tools like Soundtrap are built for all ages and ability levels, 

so everyone from beginners to advanced learners can create together. Because students 

listen as well as speak, audio stories can build empathy: hearing someone’s accent or 

laughter directly can be powerful. 

4.3.9 Accessible Audio Tools 
● Audacity (free software): A popular, open-source audio recorder and editor that 

runs on Windows, Mac, and Linux. It lets students record voice tracks and layer 

sounds. 

● Soundtrap (online studio): A web-based music and podcast studio that works on 

any device. Teachers note it empowers students, and is for all ages and ability 

levels. It also supports collaboration (students can work on a project together 

online). 

● Voice recorder apps: Most smartphones and tablets have a built-in voice recorder. 

These apps (like Voice Memos on iPhone or Recorder on Android) let students 

capture sounds quickly on the go without extra equipment. 

● Free sound libraries: Websites such as Freesound.org offer free sound effects 

(check licenses). Students can safely download ambient noises, instrument notes, 

or Foley effects to use in their stories if needed. 

4.3.10 Sample Activities for Workshops 
● Soundwalk: Take a silent walk outside or around the school. Ask students to focus 

on and note or record the sounds they hear (birds, traffic, voices, etc.). Back in class, 

play the sounds and let each student describe how the soundscape made them feel 

or what story it tells about the place. This activity (inspired by the World Soundscape 

Project) trains conscious listening (C4K, 2021). 

● Soundmap: Give students a map of the neighborhood or a room. Have them mark 

spots and collect sounds from each spot (using phones). For example, record a car 

engine on the road, a fountain at the park, footsteps in the hallway. Then play back 

the clips while pointing to each location, creating a sonic map of the space. 

● Audio Diary / Journal: Encourage students to keep a daily audio journal. They can 

use their phone to record a short voice clip about something that happened or an 
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interesting sound (e.g., rain on the window, family dinner chat). Later, they select a 

few clips and mix them into a mini-narrative day in the life. This lets them reflect on 

what their everyday environment sounds like. 

● Podcast or Radio Story: Have students pick a topic (their favorite day, a myth from 

their culture, etc.) and write a short script. In pairs or small groups, one student can 

be the “host” reading the script, while others provide background audio: ambient 

noise, sound effects or music. They record and edit this like a radio segment or 

podcast episode (similar to the “Voices of Inclusion” example where students 

recorded personal stories (Inclusive Schools Network, 2025). 

● Sound Collage (Group): In teams, students choose a theme or scene (e.g., busy 

market, stormy night, celebration). Each student records 2-3 sounds related to the 

theme (chopping vegetables and chatter for market, thunder and rain for storm). 

Using Audacity or Soundtrap, they layer all the sounds to create a 1-2 minute audio 

collage. Then each group shares their collage and explains how the sounds 

combine to tell a story about the chosen theme. 

 

4.4 Innovative Digital Tools 
Incorporating digital tools into youth work enhances engagement, fosters creativity and 

supports inclusive storytelling. When selecting tools, consider accessibility, ease of use 

and the ability to facilitate collaboration and expression. Below is a curated list of 

recommended tools, along with tips for ensuring accessibility and inclusion. 

4.4.1 Criteria for Selecting Tools 
● User-Friendliness: Tools should have intuitive interfaces that are easy for youth to 

navigate, regardless of their technical skills. 

● Accessibility: Ensure tools are accessible on various devices, including 

smartphones and tablets, to accommodate different user needs. 

● Collaboration Features: Choose tools that allow for real-time collaboration, enabling 

youth to work together and share ideas seamlessly. 

● Cost-Effectiveness: Opt for free or low-cost tools to make them accessible to all 

participants. 
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● Support for Diverse Media: Select tools that support various forms of media, such 

as text, images, audio and video, to cater to different storytelling methods. 

4.4.2 List of Recommended Tools 
1. Miro: A collaborative online whiteboard platform that facilitates brainstorming, 

planning and storyboarding. Miro's intuitive interface and real-time collaboration 

features make it ideal for group activities and visual storytelling projects.  

2. Canva: A user-friendly graphic design tool that allows users to create visually 

appealing content, including posters, presentations and social media graphics. 

Canva offers a wide range of templates and design elements, making it accessible 

for beginners.  

3. Soundtrap: An online audio recording and editing platform that enables users to 

create music, podcasts, and other audio projects collaboratively. Soundtrap's cloud-

based nature allows for easy access and collaboration from any device.  

4. Padlet: A digital canvas that allows users to post notes, images, links and other 

media in a collaborative space. Padlet is versatile and can be used for various 

activities, including brainstorming sessions, storytelling and sharing resources.  

5. Twine: An open-source tool for creating interactive, nonlinear stories. Twine is 

particularly useful for developing choose-your-own-adventure narratives and can be 

customized with variables and conditional logic for more complex storytelling.  

6. Dedoose: A cloud-based application designed for analyzing and visualizing 

qualitative and mixed methods data. Dedoose is useful for coding and analyzing 

narratives, making it suitable for autoethnographic projects.  

4.4.3 Tips for Accessibility and Inclusion in Digital Environments 
● Provide Training and Support: Offer tutorials and guidance to help youth become 

familiar with the tools and their functionalities. 

● Ensure Device Compatibility: Select tools that are compatible with a range of 

devices, including smartphones, tablets and computers, to accommodate different 

access levels. 

● Encourage Diverse Expression: Promote the use of various media forms to allow 

youth to express themselves in ways that are 

comfortable and meaningful to them. 

● Foster Collaborative Environments: 

Utilize tools that support real-time 

collaboration, enabling youth to work 

together, share ideas and provide 

feedback to one another. 

● Be Mindful of Language and Content: 

Ensure that the language used 

within the tools is inclusive and 

that content is appropriate for all 

participants. 

● Adapt to Individual Needs: Be 

flexible and willing to adapt 

activities and tools to meet the 
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diverse needs of youth participants, ensuring that everyone has an opportunity to 

engage meaningfully. 

By thoughtfully selecting and utilizing these digital tools, youth workers can create 

engaging, inclusive and empowering storytelling experiences that resonate with young 

people and promote anti-racism and active citizenship. 

 

4.5 Guiding Principles for Youth Workers 
Planning and facilitating storytelling workshops with young people offer a powerful 

opportunity to promote anti-racism, inclusion, and active citizenship. To maximize the 

impact of these workshops, youth workers need to thoughtfully design sessions that are 

engaging, respectful and supportive of diverse voices (Cluskey et al., 2021). Below are 

some guiding principles to help youth workers plan and manage storytelling activities that 

center equity, cultural respect, and psychological safety. 

● Start by defining clear objectives that highlight not only storytelling skills but also 

fostering awareness of systemic racism and celebrating diverse identities. Consider 

the backgrounds and experiences of participants, ensuring activities reflect their 

realities and empower marginalized voices. Use icebreakers and introductions to 

build trust and create a welcoming environment where every participant feels 

valued. 

● Structure the workshop in phases, starting from story discovery and identity 

exploration, to scriptwriting and media production. Embed discussions around 

power, privilege and representation throughout to encourage critical thinking and 

empathy. When selecting story topics or themes, prioritize issues relevant to anti-

racism and inclusion, such as challenging stereotypes, recognizing bias and 

celebrating cultural diversity. 

4.5.1 Script Development and Pre-Production Tips 
Script development is a key moment for reflection and inclusion. Encourage participants to 

write stories that challenge racism, highlight underrepresented perspectives, or share 

personal experiences related to identity and belonging. Youth workers should guide 

participants to critically examine their narratives for unconscious biases and encourage 

respectful language. Provide prompts that foster critical thinking about societal structures, 

discrimination and community resilience. Use collaborative scriptwriting, when possible, to 

ensure multiple voices shape the story. In pre-production, discuss ethical considerations 

such as consent, representation and the potential impact of the story on participants and 

audiences. 

4.5.2 Ensuring Psychological Safety and Cultural Respect 
Creating psychological safety is essential for authentic storytelling. Youth workers should 

foster an environment where participants feel safe to express themselves without fear of 

ridicule or backlash. This involves active listening, validating experiences and being 

mindful of cultural differences in communication styles. Respect for cultural practices, 

identities and histories should be central to all activities. Avoid tokenism by ensuring stories 

are not reduced to stereotypes or oversimplified narratives. Instead, support participants 

in telling complex, nuanced stories that honor their lived realities. Ongoing reflection and 

feedback sessions can continuously help participants process emotions and reinforce a 
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culture of respect and inclusion. Youth workers themselves should engage in continuous 

learning about anti-racism and culturally responsive facilitation techniques to better serve 

diverse groups. 

 

4.6 Practical Templates and Prompts 
4.6.1 Storyboard Template 
Storytelling is described as a powerful medium that can amplify youths’ voices and 

strengthen social connection. Use the prompts below to outline each scene, making sure 

to include characters of different backgrounds and to avoid stereotypes: 

● Story Title: _________________________________ 

● Main Character(s) (identities/cultures): _________________________________ 

● Supporting Character(s) (backgrounds): _________________________________ 

● Setting & Time Period: _________________________________ 

● Scene 1 (Beginning - Setup): _________________________________ 

● Scene 2 (Middle - Conflict/Development): ________________________________ 

● Scene 3 (Climax - Turning Point): _________________________________ 

● Scene 4 (Ending - Resolution): _________________________________ 

● Representation Check: Who is included in this story? Are all characters (of different 

races, cultures, abilities, etc.) portrayed respectfully? 

4.6.2 Autoethnography Reflection Sheet 
This sheet guides youth in reflecting on identity, culture and personal experience. Personal 

history is treated as a cultural reference point that shapes how we see others. The prompts 

below help youth write about themselves and connect their story to broader social issues: 

● Identity Words: List words that describe you (traits, hobbies, cultural background, 

language, etc.)? 

● Family/Heritage: How would you describe your family’s background or heritage 

(race, ethnicity, religion, origin)? 

● Community/Place: Where did you grow up or spend most of your time? What was 

that community like? 

● Values & Traditions: What traditions, values, or beliefs shaped you? 

● Experiences of Difference or Fairness: Have you ever felt treated differently (better 

or worse) because of who you are? Describe it. 

● Connecting to Society: What larger issues (e.g., race, class, gender, fairness) relate 

to these experiences? How do they connect your personal story to systemic issues? 

4.6.3 Soundscape Planning Sheet 
A soundscape is any acoustic environment, combining cultural sounds, natural sounds and 

noise of a place. This sheet helps youth choose and layer sounds to tell a story about their 

community or theme: 

● Theme/Story: What is the story or mood you want to create with sound? (e.g., a day 

in your neighborhood, a celebration, a social issue) 

● Location & Ambience: Where does this take place (city street, forest, home, etc.)? 

What background sounds are naturally there (birds, traffic, machinery)? 

● Key Sounds (List by category): 

⮚ Natural/Ambient: _________________________________ 
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⮚ Human/Voices: _________________________________ 

⮚ Music/Song (if any): _________________________________ 

⮚ Other Cultural or Symbolic Sounds: ________________________________ 

● Sequence & Layering: In what order will sounds appear and overlap? (e.g., start 

with ambient sound, then add voices or music) 

● Emotional Tone/Meaning: What feeling or message does each sound convey (e.g., 

calm, busy, proud, tense)? 

● Technical Notes: How will you record these sounds? (location, time of day, 

equipment) 

● Story Connection: How do these sounds represent your community, identity or the 

theme of your story? 

4.6.4 Facilitator Reflection Prompts 
Youth workers use these questions to examine their own assumptions and ensure inclusive 

facilitation. Anti-bias guides advise instructors to reflect on identity and how it shapes lived 

experiences and to ask, “Who might be left out of this activity? How will I include them?” 

Use these prompts before or after a workshop: 

● Inclusivity: Who might be missing or underrepresented in this story/activity? How 

can I include their perspective so that no one is invisible?  

● Bias and Assumptions: What stereotypes or assumptions might I or the youth hold 

about this topic or group? How will I challenge or correct them?  

● Language & Materials: Am I using respectful, inclusive language and materials? 

Have I avoided terms or images that others might find offensive? 

● Youth Agency: How am I encouraging youth to lead and own their stories? Am I 

listening to their ideas and choices without imposing my own? 

● Self-Reflection: How might my own identity (race, gender, culture, etc.) and 

experiences affect how I facilitate this session? 

● Context & Justice: Does the activity acknowledge broader issues (like inequality or 

history)? How can I highlight connections to justice or fairness in the discussion?  

 

4.7 From Method to Media: Preparing for 
Participatory Video Projects 
Building on earlier activities (storyboards, soundscapes, autoethnography), storyboarding 

and audio workshops train young people to visualize stories and play with sound before 

filming. For example, one guide emphasizes that participatory video “is at its core about 

storytelling,” encouraging participants to “describe their own individual stories” and learn 

the film tools to tell them (SUNRISE Network, n.d.). In practice, facilitators can have youth 

co-develop scripts and visual storyboards as they did with the SARUTO project, where 

participants set shared expectations and “collaborate on the creation of a script or visual 

storyboard” before shooting (Contextos, Lascò Srl, and Associación Fronteiras, 2022). 

These pre-production exercises also create a safe space, simple group exercises like short 

recording/playback games build confidence (“sense of can-do”) without pressure to 

perform (Contextos, Lascò Srl, and Associación Fronteiras, 2022). By the time camera 

time arrives, youth have rehearsed expressing ideas and reflecting on personal 
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experiences (via autoethnography), so they can co-create meaningful video. 

As the project shifts into production, facilitators guide youth from reflection to action. Early 

co-working on story plans naturally leads into filming: groups may interview community 

members or shoot scenes that illustrate their theme. The SALTO DIGITART guide notes 

that after reflection, “participants will develop performance capacities playing with the 

camera and getting acquainted with the video-making and editing process” (Contextos, 

Lascò Srl, and Associación Fronteiras, 2022). Practically, this means moving from paper 

and pen to cameras and mics: facilitators should demonstrate camera basics (framing, 

focus, recording sound) and set up collaborative roles (director, cameraman, interviewer, 

etc.), always looping back to reflection. For instance, a youth video field guide reports that 

showing participants live editing demos (e.g., how clips are cut and music added) early on 

demystified editing and let every young person suggest what to include or 

cutsunrisenetwork.org. In short, the techniques learned in storyboarding, sound projects, 

visual thinking, attentive listening and trust in one’s voice become the foundation for group 

video co-creation. 

Inclusive, anti-racist participatory video: To ensure equity and representation in the 

media-making process, we follow a 

collaborative framework.  

Key principles include: 

● Ongoing consent and ownership: 

Make clear from the start how footage 

will be used. Adopt ongoing informed 

consent, at each stage, youth can 

agree or withdraw. In one project, 

facilitators built in multiple consent 

checkpoints so participants could 

agree on how narratives are framed or 

withdraw participation (Lenette et al., 

2020). This respect for freedom goes 

hand in hand with treating participants 

as authors. A collaborative editing 

process involving youth in decisions 

about cuts, sequencing, music, etc., ensures the final video truly reflects their 

perspective. As Lenette et al. (2020) notes, when youth have a strong sense of 

ownership of the videos as narratives, it boosts their agency and reduces the chance 

that adults will misrepresent their stories. 

● Amplify every voice: Design activities so everyone can contribute ideas and 

feedback. Facilitators should circulate cameras and airtime, asking each youth what 

to film and how to present it. During editing, invite all participants to watch rushes 

and direct changes. One field report emphasizes that an inclusive editing process 

ensured every individual had a voice in shaping the final video, yielding a film that 

matched the group’s collective (SUNRISE Network, n.d.). This means resisting 

hierarchies, shy or marginalized youth must be encouraged gently to speak, and 

confident youth coached to listen. Building from the autoethnography work, 
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facilitators can ask, “Whose story is this? Who else should we interview? How do 

we represent different perspectives?” 

● Collaborative creation: From day one, structure the project as teamwork. Pair or 

group youth for interviews or filming, have them plan shots together and solve 

problems jointly. The DIGITART guide stresses alternating action and reflection: film 

segments, then pause to watch and discuss them as a group (Contextos, Lascò Srl, 

and Associación Fronteiras, 2022). This cycle keeps everyone engaged and 

accountable. Importantly, as the group learns, facilitators should gradually step 

back. Research on participatory video notes that facilitators initially lead group 

formation and skill-building, but then should gradually step back to let the group lead 

the process as it gains more confidence and awareness (Contextos, Lascò Srl, and 

Associación Fronteiras, 2022). In practice, that means moving from facilitating 

closely to acting more as mentors, supporting without commandeering. 

● Ethical editing and representation: Use editing as an ethical tool. Let youth cut 

scenes, rearrange sequences based on the storyboards and contribute to the 

overall storytelling process (SUNRISE Network, n.d.). We must be especially 

cautious about race and stereotype, e.g., avoid editing footage so that any group 

appears monolithic or their words taken out of context. Whenever possible, let 

participants view and comment on near-final cuts. As one study reflects, giving 

youth control over editing helped them reduce the likelihood of misrepresenting their 

ideas (Lenette et al., 2020). Strive for representation that is accurate and 

multifaceted, include people of different races and genders, and let young 

filmmakers choose how to depict cultural identity. In all decisions, prioritize the 

voices of racialized youth and consider the equity dimension of who is seen and 

how, carrying forward the respect and critical awareness fostered by earlier 

chapters. 

 

4.8 Final Reflections and Next Steps 
Participatory video can ignite a lasting spark of engagement and self-expression in youth. 

By owning their stories on film, young people often emerge more confident about speaking 

out. Research from youth-centered projects shows that participants gain real-world 

knowledge and civic confidence. For example, one study found that after creating a video 

about local issues, youth had “increased awareness and knowledge” of community 

concerns and “greater confidence to question community members and decision-makers,” 

sometimes communicating problems more effectively than adults (Haynes and Tanner, 

2015).  

These outcomes illustrate that media projects can transform learning into action. According 

to Haynes and Tanner (2015), youth who co-produce films learn to see themselves as 

capable messengers, their emotional, credible and encouraging voices carry weight. In 

practice, facilitators observe that participants often continue asking questions and sharing 

with peers long after the workshop ends, fueled by the pride of making a film of their own. 

To sustain this momentum, youth workers should embed anti-racism in everyday practice. 

Anti-racist engagement is not a one-off lesson but a commitment. Continuously encourage 

self-reflection and dialogue about race and power in each project. For instance, facilitators 
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can model the cultural humility they taught earlier, admitting what they do not know, 

learning from youth and actively seeking diverse perspectives (Equitas, 2024). Whenever 

controversial stereotypes or discriminatory language arise (in media or conversation), 

address them openly using human-rights frameworks (Equitas, 2024).  

Commit to ongoing learning: use materials and examples that center voices of color, and 

make anti-racism a regular discussion, not an add-on. (Equitas, for example, urges youth 

workers to connect discrimination observations to global human rights standards, holding 

institutions accountable (Equitas, 2024). Encourage young participants to become anti-

racist peers and allies. For example, let them advise each other in editing to avoid biased 

representation or have them mentor newcomers on inclusive storytelling. The key is to 

make justice and dignity a default goal of all youth activities. 

4.8.1 Youth-led Storytelling 
Help youth to see this workshop as the beginning of their creative journeys. Suggest 

forming media clubs or writing groups where participants keep practicing. Schools and 

community centers can host regular screenings or story nights where youth share their 

videos or zines; one participatory video project ended with students organizing a 

celebratory public screening complete with refreshments, showcasing their work to friends 

and family (SUNRISE Network, n.d.). 

● Online platforms also offer avenues: youth might post videos on a class blog or start 

an Instagram channel for storytelling, extending reach while guiding them on safe 

sharing. 

● Advocacy is another path: some youth may choose to present their films to local 

officials or community leaders, as happened in the climate-adaptation study where 

young filmmakers used their videos to press village councils into action (Haynes 

and Tanner, 2015). 

● Even informal sharing counts: encourage them to tell their stories at community 

events, submit to youth film festivals or hang photo-and-quote exhibits at a local 

library. 

In conclusion, remember the guiding principles of this guide (let young people choose their 

topics, teach them the craft and trust their voices). Youth media projects have shown time 

and again that when young creators see themselves as capable of effecting change, they 

continue to engage creatively and critically with the world (Greenaway 2016; Haynes and 

Tanner, 2015). By fostering these opportunities through clubs, online projects, exhibitions 

and civic action, youth workers can encourage the anti-discriminatory and empowered 

spirit born in the workshop to expand into other arenas. As one youth media editor says of 

her experience, it felt real when young people were given platforms to speak for themselves 

(Greenaway 2016). Let us keep creating such platforms, believing that every teen’s story 

is valuable and every voice is needed. 
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Chapter 5. Technical Guide for 
the Creation of a 
Participatory Video 

 

What is a Participatory Video? 
Participatory Video (PV) is a community-centered approach to filmmaking. In PV, the 

traditional roles of filmmaker and subject are shared. Instead of being passive recipients 

of a filmmaker's view, the people who are usually “filmed” take an active role in every stage 

of the video-making process. In addition to telling a story, they also shape, film, edit and 

decide where and how it is shown. 

 

PV is about the democratisation of storytelling. It gives voice to people who are often 

underrepresented in mainstream media and enables them to define their narratives in their 

own terms. This process is not only creative but also empowering and transformative. 

How Does Participatory Video Work? 

The process typically involves: 

● Collaborative Planning: The participants decide what issues or stories are most 

important to them. 

● Skills Training: Participants learn how to use cameras, record sound, conduct 

interviews and edit footage. 

● Filming Together: The group films within their own communities, often taking turns 

behind and in front of the camera. 

● Reflective Discussion: Based on collective values, teams review their footage and 

decide what to include or exclude. 

● Community Screenings: The final video is shared with 

others, sparking discussions, dialogue or 

even policy change. 

 

5.1 Why Participatory 
Video? 
When people own their stories, they unlock new 

possibilities for personal growth, collective action 

and social change.  

PV is a transformative approach that: 

- Empowers: PV gives people control over how 

their stories are told, helping to restore 

confidence, especially in marginalised or silenced 

communities. 
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- Builds Capacity: Participants gain technical and communication skills, including camera 

use, interviewing, teamwork and media literacy competencies that can be used beyond the 

project. 

- Develops Social Connection(s): Working together on a creative project builds trust, 

empathy and shared purpose among diverse community members. 

- Advocates and Raises Awareness: The final video can be used to engage decision-

makers, raise public awareness, influence policy or document lived experiences for future 

generations. 

- Reflects and Heals: The act of telling one’s story and being heard can be a form of 

emotional or social healing, especially for communities facing trauma or exclusion. 

 

5.2 Principles and Ethics of Participatory Video 
PV is also a value-based practice. The method requires more than teaching people how to 

use a camera. It calls for building relationships, practicing mutual respect and engaging 

ethically with every person involved. 

The principles and ethics of PV guide how we approach communities, make decisions and 

care for each other throughout the storytelling process. These values ensure that the 

process is safe and inclusive and that every voice leads to meaningful impact. 

5.2.1 Participation: Everyone Has a Voice 
Participation means active involvement from beginning to end, not just appearing on 

camera. Community members: 

● Decide which topics are meaningful or urgent. 

● Contribute ideas, stories and visuals. 

● Take on roles such as camera operator, interviewer, editor or facilitator. 

No one is “just a subject.” Every person has the right to shape their representation and 

the way their story is told. True participation also means making space for quiet voices, 

ensuring inclusivity across age, gender, ability and background. 

Good practice: Use inclusive group activities like story circles or drawing timelines to 

help everyone contribute in a way that suits them. 

5.2.2 Informed Consent: Clear, Ongoing, and Respectful 
Informed consent is not just a signed form, it’s a continuous process of ensuring 

understanding and freedom of choice. 

● Explain the project in clear, jargon-free 

language. 

● Clarify how and where the video will be 

used (for example: online, at festivals, in 

workshops). 

● Allow people to say no at any stage - 

before, during or after filming. 

For vulnerable individuals (children, trauma 

survivors, etc.), take extra care to protect 

their rights and emotional well-being. 
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Ethical tip: Ask, “Would this person feel safe if this video was seen publicly tomorrow?” If 

there’s doubt, revisit the content with the group. 

5.2.3 Transparency: Clear Intentions and Open Communication 
From the very start, facilitators must be honest about their intentions, timelines and 

potential impact. This builds trust and helps participants feel secure. 

Transparency includes sharing the following information: 

Who is funding the project? 

Who will see the final product? 

What happens after the film is finished? 

Are there any risks to participating? 

Good practice: Revisit the group’s expectations at each stage to avoid 

misunderstandings. 

5.2.4 Power Sharing: Co-Creation, Not Control 
Traditional media often reflects the power of those holding the camera. PV intentionally 

challenges this by redistributing power: 

● Participants decide what is filmed and how it’s edited. 

● Facilitators act as guides or supporters, not directors 

Disagreements are navigated through discussion and group decision-making. This 

approach nurtures collective ownership and prevents exploitation or bias. 

Ethical tip: Don’t rush decisions. Make space for the group to pause, reflect and decide 

together - even if it slows the process. 

5.2.5 Do No Harm: Emotional, Cultural and Physical Safety 
Participatory Video often touches on personal or sensitive issues, from migration stories 

to community conflicts. Facilitators must create a safe, supportive environment: 

● Respect cultural norms and practices. 

● Avoid re-traumatizing participants through difficult topics. 

● Ensure physical safety during filming (for example: avoid dangerous locations, use 

equipment properly). 

● Provide emotional support, and follow up after sensitive discussions. 

Good practice: Plan for moments of group reflection and check-ins, especially after 

emotional interviews or scenes. 

Additional Ethical Considerations: 

Confidentiality: Blur faces or use pseudonyms if anonymity is needed. 
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Representation: Avoid reinforcing stereotypes; support stories that reflect dignity and 

complexity. 

Ownership & Archiving: Decide together who keeps the footage, who can share it and 

how it will be stored or used long-term. 

 

5.3 Story Generation Tools and Collaborative 
Storytelling 
Participatory Video is also about reframing it through a collective lens, using tools that 

help uncover deeper truths, inspire creativity and engage different styles of thinking. 

Below are creative techniques and games for group story development, especially when 

working with social topics, truth vs. fiction or diverse perspectives. 

5.3.1 Creative Story-Building Techniques 
5.3.1.1 Parallel Stories in Two Groups 

Setup: Divide participants into two groups. Give both the same topic or event (e.g., "The 

Day the Internet Broke"). Task: Each group creates a short narrative independently. 

Outcome: Compare stories. Discuss how different interpretations or biases emerge 

based on perspective, context and experience. 

Use this to demonstrate that every story is framed, and framing is a choice. 

5.3.1.2 Unconnected Words to Story 

Setup: Each participant contributes a random word (objects, feelings, 

places). Task: The group must create a coherent story using all the words. 

Outcome: Encourages flexibility, lateral thinking and collective creativity. 

Bonus: Connect random words to real social issues. Example: “Apple, Fence, Silence” 

→ A story about food insecurity and borders. 

5.3.1.3 Rolling a Numbered Dice (Quantity-Based Creativity) 

Purpose: Add constraints or creative challenges based on the number rolled. 

How it works: 

Participants roll a standard numbered dice (1-6). 

The number corresponds to how many creative elements they must incorporate into their 

story. 

Examples: 

Roll a 3 - Add 3 new elements, such as: 

● A metaphor (e.g., "like a caged bird")  

● A color theme (e.g., everything red) 

● A cutaway scene (e.g., a dream or flashback) 

Roll a 5 - Include 5 symbolic objects or sensory details (e.g., smell, texture). 

This method boosts spontaneity and forces the group to work beyond their comfort zone. 

Great for deepening creativity under playful pressure. 

5.3.1.4 Story Dice (Idea Prompting with Visuals) 

Purpose: Use images or icons to spark inspiration or structure a scene. 

How it works: 

Use physical or digital story dice with drawings/icons instead of numbers (see StoryDice 

by Dave Birss https://davebirss.com/storydice/). 

Roll 2-5 dice and interpret the pictures as symbols, characters, actions or locations. 

https://davebirss.com/storydice/
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Examples: 

Rolled images: 🔒 (lock), 🌊 (wave), 👣 (footprints) - Could inspire a story about 

escape, migration or secrets left behind. 

Rolled images: 🐦 (bird), 📱 (phone), 🔥 (fire) - Might lead to a narrative about 

spreading misinformation on social media (like wildfire). 

This method is visual and open-ended, ideal for groups that think in symbols, metaphors 

or images, and for introducing poetic elements into documentary stories. 

5.3.1.5 Object Storytelling 

Setup: Ask each participant to bring an object that holds personal or symbolic meaning. 

Task: Share the story of that object and what it represents in their life. 

Filmmaking Link: Use these objects visually in the final film or as metaphors to develop 

scenes. 

Objects can anchor personal memory to collective history and can serve as documentary 

narratives. 

5.3.1.6 Emoji Story Challenge 

Setup: Present participants with 3-5 random emojis. 

Task: Create a story inspired by or connecting these emojis. 

Variation: Use emojis to express emotional arcs (e.g., 🙄 → 😠 → 😢 → 😍 

→ ✊)   This technique is especially engaging for young people and digital 

storytelling. 

5.3.1.7 Butterfly Effect: Change One Detail 

Setup: Take an existing story or scene and change one key detail (time, person, location 

or decision). 

Task: Recreate the story with that altered element and explore how the outcome 

shifts. Use in PV: Reflect on how small decisions (or misinformation) lead to 

drastically different community realities. 

Ideal for stories involving systemic change, misinformation or resilience. 

5.3.1.8 Role-Playing Debate: Misinformation vs. Truth 

Setup: One team presents a fictional narrative based on misinformation. The other 

team plays fact-checkers, journalists or affected citizens. 

Task: The "truth" team must debunk the misinformation, using stories, fact-check-tools, 

emotional appeals or personal experience. 

Outcome: Sparks real-time critical thinking and demonstrates the power of narrative in 

shaping beliefs. 

Use this to raise awareness of media literacy and promote critical engagement. 

These techniques enhance narrative depth, emotional authenticity and group cohesion. 

5.3.1.9 Role-Playing Scenarios 

Enact scenes based on real-life issues (e.g., police encounters, job interviews, hospital 

visits). 

Explore multiple characters' perspectives. 

Use recordings as narrative brainstorming or documentary material (with consent). 

5.3.1.10 Forum Theatre (from Theatre of the Oppressed) 

Present a short scene of social injustice. 

Invite the audience to step in and try to change the outcome by taking the role of the 
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protagonist. 

Discuss: What worked? What failed? What alternatives exist? 

Teaches agency and the consequences of action/inaction in real-world dilemmas. 

5.3.2 Visual and Structural Tools for Social Narratives 
5.3.2.1 Timeline Mapping for Community Memory 

Visualize a timeline of key local or historical events. 

Connect these with personal moments or emotions. 

Helps generate stories rooted in shared or inter-generational experience. 

5.3.2.2 Storyboarding Social Change 

Sketch scenes that represent "before," "during," and "after" a problem or intervention 

(e.g., a protest, a flood, a law). 

Emphasize visual metaphors and narrative rhythm. 

5.3.2.3 Character Constellations 

Map out all stakeholders in a story: community members, institutions, outsiders, systems. 

Define who holds power, who is marginalized, and who drives change. 

Narrative Function Roles (used in storytelling, screenwriting & social impact docs):  

Protagonist - not always a hero, but the central figure driving the action. 

Antagonist - the force (person, system, idea) working against the protagonist’s goal. 

Catalyst - causes change without undergoing it themselves (e.g., an outsider 

arriving). Confidant(e) - the character who listens and helps reveal the protagonist’s 

inner world. Foil - contrasts with another character to highlight traits (e.g., hopeful vs. 

cynical). 

Narrator - may be within or outside the story; frames how we interpret the events. 

Shadow - represents the repressed, feared, or destructive part of a system or 

person. 

Sociological and Community-Based Roles (excellent for non-fiction and social 

justice storytelling): 

The Gatekeeper - controls access to spaces or resources (e.g., school director, 

elder).  

The Insider - part of the group being portrayed, with lived experience. 

The Outsider - external observer, may bring objectivity or misunderstanding. 

The Bridge-Builder - connects different groups or generations. 

The Silenced - those whose stories are usually hidden or erased. 

The Resister  -  challenges the system, sometimes quietly or 

creatively. The Follower - shaped by others’ actions; not passive, but 

affected. 

The Transformative Agent - someone who evolves and causes others to evolve. 

5.3.2.4 Stakeholder Mapping and Community Involvement 

Stakeholder mapping is the process of identifying all the people, groups and institutions 

connected to a story, issue or community. In participatory video, this step is essential to 

ensure that the voices represented in the film are not only those who speak the loudest - 

but also those who are often unheard. 

This mapping lays the foundation for an inclusive and collaborative process. 
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Who is the Stakeholder? 
A stakeholder is anyone who: 

● is affected by the issue or story. 

● has power, influence, or responsibility over the situation. 

● can contribute insights, resources or perspectives. 

● might be impacted by the film or its outcomes. 

Stakeholders can be both directly involved (e.g., community members, youth) or 

indirectly related (e.g., NGOs, policy-makers, service providers, media). 

Stakeholder Categories (Examples) 

Primary Stakeholders - People with lived experience of the issue (e.g., local residents, 

youth, survivors) 

Secondary Stakeholders - Those who support or work with the community (e.g., 

teachers, NGOs, health workers) 

Institutional Stakeholders - Government bodies, schools, religious leaders, police or 

policymakers 

Challenging Voices - People with opposing views or skepticism (e.g., critics, local media, 

resistant officials) 

Invisible or Marginalized Voices - Those often left out of conversations (e.g., persons with 

disabilities, migrants, elders, LGBTQ+) 

How to Map Stakeholders (Simple Steps) - Draw a circle in the center of a large paper or 

board: this is your main issue or story topic (e.g., “access to education”). 

Add layers of people around the circle: 

Closest = most affected  

Middle = support/impact roles 

Outer = decision-makers or distant influencers 

Use colors or symbols to indicate: 

Who has power? Who 

is voiceless? 

Who can help amplify? 

Who may resist or misunderstand? 

This can be done with sticky notes, string diagrams or digitally on a collaborative 

platform. 

5.3.3 Community Involvement: Moving from Mapping to Engagement 
After mapping, it’s vital to engage stakeholders meaningfully: 

Invite them to co-create: Ask them to contribute ideas, stories, concerns or questions. 

Clarify roles: Who will film? Who wants to act, interview or provide background stories? 

Build trust: Listen actively, share your intentions and ensure there’s no hidden agenda. 

Ensure feedback loops: Let stakeholders review drafts or give input before final 

decisions. Create safe spaces: Especially for vulnerable groups, make sure 

participation is voluntary, informed and empowering. 

5.3.4 Why It Matters in Participatory Video 
Representation: The story reflects many realities, not just one dominant 

voice. Trust: Early collaboration avoids conflict or suspicion later. 

Ownership: People feel pride and connection when their voices shape the story. 
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Impact: A more inclusive film has stronger social resonance and potential for 

change. Workshop Ideas 

Power & Voice Map: Have participants rank stakeholders by how much power they have 

and how much voice they have in the issue. Then discuss imbalances. 

“Who’s Not in the Room?” Exercise: Regularly ask during production - who is missing 

from this conversation? How can they be involved? 

Stakeholder Walk: Physically walk through a neighborhood or community space 

identifying people or groups relevant to the topic. 

5.4 Technical Basics: Camera, Sound, Lighting 
You don’t need fancy equipment to make impactful videos.  

The basics include:  

● Camera: How to hold a shot steady, frame a subject and use movement 

purposefully. 

● Sound: The importance of clear audio, such as using mics or minimizing noise. 

● Lighting: Using natural light effectively or adjusting for indoor setups.  

● Participants gain hands-on practice with tools they can access, like smartphones 

or basic gear. 

5.4.1 Camera: How to Film Confidently with What You Have 

Equipment Options 

Smartphones (ideal for participatory video - familiar, 

accessible and portable) 

Consumer cameras or DSLRs (but need training) 

Webcams (useful for interviews or indoor storytelling) 

Framing the Shot (Composition) 

Rule of Thirds: Imagine your screen divided into 9 equal parts 

by two vertical and two horizontal lines. Place your subject 

along these lines or at the intersections. 

Headroom and Lead Room: 

Headroom: Don’t crop too close to someone’s head; leave a 

bit of space. 

Lead Room: If someone is looking or moving in a direction, 

leave space in front of them. 

Angles and Perspectives: 

Eye-level is natural and respectful. 

Low-angle can empower a subject, while high-angle can 

diminish them. Vary your angles to keep the video visually 

engaging. 

Stability 

Hold the camera with two hands or use a tripod (or improvise: books, tables, wall). 

Avoid fast panning (moving the camera side to side quickly), as it can make viewers 

dizzy. Use static shots (camera stays still) for interviews or reflective moments. 

When to use a handheld camera 

Types of Shots 

Wide Shot: Shows the environment and the subject's place in it. 
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Medium Shot: From the waist up; common for conversations. 

Close-Up: Focuses on the face, emotions or hands (great for emotion and details). 

5.4.2 Sound: Making Sure We Can Hear Every Voice Clearly 
Many viewers will tolerate average visuals, but poor sound ruins 

engagement. If the message isn’t clear, the story loses power. 

Sound Tips (Even Without a Microphone) 

Get Close to the Subject: The closer the mic (or phone) is to the speaker’s 

mouth, the better. 

Reduce Background Noise: Avoid busy roads, wind or fans. Indoors is often 

better. Monitor Sound: Record 10 seconds and play it back։ can you hear 

clearly? 

Use DIY Microphones: Earbuds with a built-in mic work better than holding the 

phone far away. 

Optional: Using External Mics 

Clip-on/Lavalier Mic: Attaches to clothing, great for interviews. 

Shotgun Mic: Directional, ideal for group conversations or filming at a 

distance. If using these, check compatibility with your phone or camera. 

5.4.3 Lighting: Helping the Audience See Clearly 
Natural Light - Your Best Friend 

Use daylight whenever possible։ it’s free and beautiful. 

Face the Light: Always have the subject face the window, not with 

their back to it. Otherwise, they will appear as a dark silhouette. 

Avoid Harsh Shadows: Overhead sunlight (like midday) creates 

shadows under the eyes. Early morning or late afternoon light is 

softer and more flattering. 

Indoor Lighting Tips 

Use lamps, LED lights or even white walls to reflect and soften 

light. 

Avoid mixing light colors (e.g., yellow lamps and blue daylight), 

which can look unnatural. Three-point lighting (if available): 

● Key light - the main source (brightest) 

● Fill light - softens shadows (often a white surface or 

secondary lamp)  

● Backlight - creates separation from the background 

Bonus Tips for Beginners: 

● Shoot horizontally, not vertically (unless you’re making a video for TikTok or 

Instagram Reels). 

● Before filming, clean your camera lens with a soft cloth or shirt. 

● Film a test clip to check everything: lighting, framing, sound and focus. 

Keep a checklist before you start shooting:  

Is the lens clean? Is the subject in frame? Is the lighting good? 

Is the background clean and non-distracting? Can you hear clearly? 
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5.5 Interview Techniques and Informed Consent 
Interviews are one of the most powerful and direct ways to let people tell their own 

stories in a participatory video. Done well, they build trust, encourage honesty and help 

uncover meaningful insights. But interviews must always be approached with care, 

respect and ethical responsibility - especially when working with vulnerable groups or 

sensitive topics. 

5.5.1 Encouraging Real Stories 
a. Ask Open-Ended Questions 

Instead of “yes or no” questions, ask ones that begin with: 

“Can you tell me about…?” “How did you feel when…?” “What happened next?” 

This encourages people to speak freely and go deeper into their experiences. 

b. Listen Actively and Respectfully 

Make eye contact (if culturally appropriate). 

Nod or give short verbal signs to show attention. 

Don’t interrupt and let silences happen. Sometimes silence invites deeper reflection. 

c. Create a Comfortable Environment 

Choose a quiet, safe and familiar setting when possible. 

Use minimal crew or equipment so people don’t feel overwhelmed. 

Be sensitive to the person’s emotional state - pause or stop if they seem distressed. 

d. Let the Interviewee Lead 

Don’t control the story or push for certain answers.  

Follow their pace and direction - be curious, not forceful. 

If they want to talk about something else that matters to them, let them. 

e. Use Body Language and Empathy Smile, show kindness and be patient. 

Sit at the same level, avoid standing over someone or crowding them. Informed Consent: 

Ethics Before Footage 

In participatory video, informed consent means making sure that every participant fully 

understands what they’re being filmed for and that they agree to it freely. 
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5.5.2 Clarity & Transparency 
Explain the Project Clearly: 

What is it about? 

Where will the video be shown (online, at events, etc.)?  

Who will have access to the footage? 

Use Simple Language: 

Avoid complicated legal or academic words. 

Translate into the participant’s native language, if needed. 

Consent is a Process, Not a Form: 

Always ask before filming. 

Reconfirm consent during editing and before final screening. Allow people to withdraw 

their consent at any point. 

5.5.3 Types of Consent 
Verbal Consent (recorded on video or audio) Written Consent (a signed form) 

Ongoing Consent (check in regularly, especially in longer projects) 

Tip: For youth or vulnerable persons, always involve a guardian or support worker and 

follow your country’s legal requirements. 

Respect Privacy and Boundaries. 

Avoid pressuring people to share traumatic experiences. 

Blur faces or change names if someone wants to stay anonymous.  

Don’t share clips on social media unless people have clearly agreed. 

Workshop Activity Ideas 

Mock Interview Practice: In pairs, participants take turns being interviewer and 

interviewee using real-life topics. 

Consent Roleplay: Act out good and bad consent scenarios and discuss them. Question 

Design Workshop: Together, create a list of open-ended, respectful questions related to 

your community topic. 

 

5.6 Basic Video Editing Skills 
Video editing is the process of shaping the raw footage into a clear, engaging and 

emotionally resonant story. In participatory video (PV), editing is ideally done with the 

community or participants, so the final result reflects their voice, intention and context. 

Even with no prior experience, anyone can learn the basics of editing using free or 

beginner-friendly tools. 

What Does Editing Involve? 

Editing is like storytelling with pictures, sound and rhythm. The goal is to turn many clips 

into a meaningful whole. 

5.6.1 Core Skills 
Cutting for Clarity: Trim unnecessary footage (pauses, off-topic moments, repetition). 

Focus on moments that move the story forward or express emotion. Sequencing Scenes: 

Arrange clips in a logical or emotional order. 

Think about how to introduce characters, raise questions, show events and offer 

resolution. 

You can follow a basic story arc: 
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Beginning → Middle → Turning Point → Ending. Using B-Roll for Visual Support 

B-roll = extra footage that shows context (e.g., people walking, landscapes, hands at 

work). Use it to cover cuts or support a spoken interview. 

5.6.2 Sound Editing 
Make sure voices are clear. 

Adjust volume levels to avoid sharp jumps. 

Add background music carefully - only if it enhances the emotion and doesn’t distract. 

Adding Text and Subtitles 

Subtitles increase accessibility and understanding. 

Use titles to introduce people, places or sections of the story. Keep text readable: short, 

clear and visible on screen. 

Pacing and Timing 

Let powerful moments breathe. 

Avoid rushing or dragging - watch how long scenes feel and adjust accordingly. 

5.6.3 Collaborative Editing in PV 
Watch footage together as a group - discuss what to keep or cut. 

Make editing decisions democratically: What message do we want to send? What feeling 

do we want to leave? 

Use visual boards or printed screenshots to plan the story order before opening editing 

software. 

5.6.4 Workshop Activity 
Clip Sorting Game: Give participants printed screenshots of different scenes. Ask them to 

arrange the best order to tell a story. 

Silent Edits: Remove all sound and ask viewers to guess the emotion or meaning. Then 

compare with the final version. 

One-Minute Challenge: Teams edit a 1-minute story from 5-6 random clips. It 

encourages creativity and practice. 

5.6.5 Video Apps & Tips 
OpenShot Video Editor (Free) - Desktop.  

Start a Project: Open OpenShot → Click File > New Project. Save your project: File > 

Save Project As. 

Import Media: Click the green “+” icon or drag and drop videos/images/audio into the 

“Project Files” area.  

Editing Basics: Drag media from “Project Files” into the timeline below. Use the razor tool 

or right-click > Slice to cut clips. Move clips by dragging them along the timeline.  

Add titles: Title > Title or use templates. 

Export: File > Export Project > Export Video.  

Shortcuts: Ctrl + S - Save Ctrl + Z - Undo, S - Split/Slice tool, Del - Delete clip 

Audacity (Free) - Desktop 

Start a Project: Open Audacity → File > New. 

Import Audio: File > Import > Audio or drag your file in. Editing Basics: Use the Selection 

Tool to highlight a part. Edit > Remove Special > Split Delete to cut. 

Use Effects (top menu) to clean up noise, fade, or amplify. Export as MP3 or WAV: File > 

Export > Export as MP3. 

Shortcuts: Ctrl + I - Split clip at selection Ctrl + L - Silence selection Ctrl + Z - Undo 
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Spacebar - Play/Stop 

CapCut (Free) - Mobile (Desktop) Start a Project: 

Open CapCut → Tap “New Project”. Select clips from the phone gallery.  

Import Media: Tap “Add” after selecting video/images. Use the “Audio” tab to import 

sound/music. Editing Basics: Tap a clip to edit → Use Split to cut. Tap and hold to move 

clips. 

Use “Text” or “Stickers” for overlays. 

Export by tapping the arrow icon (top-right). Gestures/Shortcuts: Pinch to zoom timeline. 

Long press to rearrange. 

Tap → “Split” for cutting. 

Adobe Premiere Pro (Paid) - Desktop Start a Project: 

Open Premiere → New Project → Name it and choose location. Import Media: 

File > Import, or drag files into the Project Panel. Editing Basics: 

Drag files into the Timeline. Use the Razor Tool (C) to cut. 

Use the Selection Tool (V) to move clips. Add text: Graphics > New Layer > Text. 

Export: File > Export > Media > H.264 (.mp4). Shortcuts: 

C - Razor (cut), V - Selection tool, Ctrl + K - Cut at playhead Ctrl + Z - Undo, Spacebar - 

Play/Stop 

Adobe Audition (Paid) - Desktop Start a Project: 

Open Audition → File > New > Multitrack Session. Import Media: 

Drag audio into tracks or File > Import. Editing Basics: 

Use the Razor Tool to split clips. 

Apply effects by right-clicking clips or using Effects Rack. Mix levels using sliders on 

each track. 

Shortcuts: R - Razor Tool Spacebar - Play/Stop, Ctrl + Shift + E - Export audio mix 

Canva (Free + Paid) - Web 

Start a Project: Go to Canva.com → Click Video > Create a blank video. Import Media: 

Click Uploads → Drag & drop video or audio. 

Editing Basics: Drag clips/images into the timeline. Export: Share > Download > MP4 

Video. 

Canva for Photo Editing 

Go to canva.com → Create a design → Choose Photo, Instagram Post, Poster, or 

Custom Size depending on your need. 

Uploading Photos: Click on Uploads (left menu) → Upload images from your device or 

drag them into Canva. 

Editing Tools: Crop & Resize - Use Crop from the top toolbar to trim or focus on parts of 

the image. Drag corners to manually resize. 

Filters & Adjustments Click Edit photo to open: 

Filters (preset looks: retro, grayscale, vivid) 

Adjust settings (brightness, contrast, saturation, blur, tint, etc.) Auto Enhance to improve 

image quality in one click. 

Background Remover (Pro only) 

Removes image backgrounds instantly for cutouts or posters. Free users can use 

Pixlr.com as an alternative (see below). Text & Elements 

Use Text to overlay messages, titles, or quotes. 
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Use Elements for shapes, icons, or visual decoration. Frames & Grids 

Use Frames to place photos in creative shapes (e.g., heart, circle). Use Grids to organize 

multiple photos in a layout. 

Exporting: Click Share > Download > PNG, JPG, or PDF depending on use. 

Pixlr.com (Free + Paid) - Web Start a Project: 

Go to Pixlr E → Create New or Open Image.  

Import Media: Use File > Open Image or drag onto canvas.  

Editing Basics: Use Crop Tool, Text Tool, Filter for effects. Good for designing title cards 

or posters.  

Export: File > Save > JPG/PNG. 

Media Libraries & Licenses 

Creative Commons (CC) License Types: 

CC0 - No credit needed. CC BY - Must credit author. 

CC BY-SA - Credit + share-alike. CC BY-ND - Credit, no changes. 

CC BY-NC - Credit, no commercial use. 

CC BY-NC-SA/ND - Same as above + share-alike/no derivatives. 

Media Sources:  

Meta Sound Collection: Meta Creator Studio > Sound Collection. YouTube Audio Library: 

YouTube Studio > Audio Library. 

Pexels.com: Free HD photos and videos, no attribution required but encouraged. 

 

5.7 Screening and Constructive Feedback 
A community screening is more than just showing a video - it’s a shared space for 

connection, learning and collective ownership. It marks a key moment in the participatory 

video process where creators, participants, and the wider community come together. 

Purpose: 

● Celebrate the work, effort and voices of everyone involved.  

● Acknowledge the stories told and those who told them. 

● Create space for emotional reactions, recognition, and reflection. 

Structure: 

Set a respectful tone: 

Remind everyone that feedback is meant to uplift, not critique harshly. 

Use a talking circle, suggestion box or moderated discussion to include everyone.  

Ask guiding questions, such as: 

What did this story make you feel or think about? 

What parts felt the most powerful or true? 

Is there something missing or that you’d want to explore further? 

What could happen next in the community because of this video? 

Include all voices: 

Invite input from children, elders and people who might be quieter (if needed). 

Use tools like sticky notes, drawing reactions or “traffic lights” (red: concern, yellow: think 

more, green: great!) for anonymous sharing. 

Outcomes of Constructive Feedback: 

Builds collective learning and future ideas. 
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Encourages community ownership of the message and next steps. 

Helps the video team see how the work is received and where they might grow. 

After the Screening 

Consider follow-up meetings or creative actions inspired by the film.  

If needed, re-edit or make short versions for different audiences. 

Share the video online, with stakeholders, or with the media only if all participants agree. 

The ultimate aim is to listen, learn and honour the shared journey, not to "judge" the film. 

Participatory video is about dialogue, empowerment and transformation. Screening is 

where that becomes visible. 
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Chapter 6: Facilitating 
Learning: From Guidelines 
to Training 

 

The HATE-LESS project offers a robust methodological framework grounded in media 

literacy, participatory action and inclusive storytelling. However, the impact of these 

methodologies depends not only on their design but also on their successful translation 

into real-world training settings. This chapter explores how youth workers and trainers can 

operationalize the HATE-LESS guidelines to deliver meaningful and engaging training 

sessions. It also discusses how the training toolkit complements the methodological 

guidelines, introduces effective strategies for building the capacities of youth workers and 

outlines follow-up mechanisms to ensure sustained engagement with young participants. 

The methodological guidelines are designed to be flexible, reflective and action-oriented. 

They encourage youth workers to engage critically with media practices, collaborate 

meaningfully with young people and communities, and foster environments where 

inclusion, creativity and dialogue can thrive. Whether used as a stand-alone resource or 

in combination with the training handbook, the aim is to support a growing community of 

practice committed to using media literacy as a force for social change. 

Turning methodology into training and practice is not a linear process. It requires facilitators 

to understand the pedagogical vision of the project, internalize its values and adapt its 

content to meet the diverse needs of youth. The training process should reflect the 

participatory, inclusive and anti-racist ethos that runs throughout the HATE-LESS 

approach. Rather than simply disseminating information, training sessions should aim to 

create spaces where young people can explore their identities, question dominant 

narratives and co-create counter-discourses that challenge hate, discrimination and 

disinformation. 

 

6.1 Bringing the Guidelines to Life 
The key to transforming theory into practice lies in how trainers design and deliver their 

workshops. Training sessions inspired by the HATE-LESS methodology should mirror the 

participatory approaches advocated in the guidelines. Each method introduced in the 

guidelines can serve as a training module. Storyboards can be used to help participants 

plan narratives that reflect their experiences with exclusion or belonging. Soundscapes 

can offer a powerful entry point into non-verbal storytelling, especially for participants with 

different linguistic backgrounds. Autoethnographic writing enables youth to explore their 

identities and social realities in a deeply personal and reflective way. These methods not 

only transmit skills but also foster empathy, critical thinking and creative agency. 

Moreover, training should follow a rhythm of exploration, reflection and creation. Activities 

can begin with the deconstruction of harmful narratives, such as analyzing examples of 
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online hate speech or misinformation, and then move into co-creating positive alternatives. 

Through this structure, training becomes a journey: one where participants not only learn 

new techniques but also begin to see themselves as capable agents of change in their 

communities. 

 

6.2 Complementing the Guidelines with the 
Training Toolkit 
The Training Toolkit developed alongside the guidelines plays a critical role in supporting 

trainers. While the guidelines provide the conceptual and methodological foundation, the 

toolkit offers the practical scaffolding needed to bring that foundation to life. It includes 

ready-to-use activity plans, facilitation scripts, editable templates and ethical guidelines 

that allow trainers to adapt methods for different age groups, cultural contexts or learning 

environments.  

Importantly, the toolkit is not meant to be a prescriptive manual. Rather, it is a flexible 

resource that encourages trainers to respond to the unique dynamics of their groups. It 

emphasizes the importance of listening, co-creation and responsiveness. Trainers are 

invited to experiment with new formats, collaborate with participants in designing activities 

and modify workshop flows based on participants’ feedback and interests. 

In combining the guidelines and toolkit, facilitators are equipped not only with tools but with 

a philosophy of training: one that centers equity, participation and creativity. This 

combination ensures that the HATE-LESS approach is not confined to paper but becomes 

a lived practice in training rooms, schools, youth centers and online spaces. 

 

6.3 Building Capacity: Training Youth Workers as 
Multipliers 
Youth workers play a central role in the HATE-LESS project - not only as facilitators but as 

multipliers of knowledge and practice. To fully inhabit this role, they need ongoing capacity-

building support. One effective strategy is the cascade training model, in which selected 

youth workers are trained to become trainers themselves. These multipliers then lead 

further trainings within their local contexts, creating a ripple effect that expands the reach 

and impact of the project. 
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Capacity-building should go beyond technical skills. It should also include reflection on 

power, representation and the ethics of facilitation. Youth workers must be prepared to 

handle sensitive discussions around race, identity and discrimination, and they need tools 

to create psychologically safe and culturally respectful learning environments. In some 

contexts, additional coaching may be required to address issues of accessibility, ensuring 

that trainings are inclusive with neurodiversity of participants, language minorities and 

youth with disabilities. 

Digital literacy is another crucial area for development. Youth workers should be 

comfortable using tools like video editing software, sound platforms or interactive 

whiteboards - not for their own sake, but as vehicles for meaningful youth expression. 

Training youth workers in both technical skills and inclusive pedagogical strategies 

ensures they are equipped to support a wide range of learning styles and needs. 

Mentorship and peer learning can also enrich capacity-building. Experienced trainers can 

support newcomers by sharing lessons learned, co-facilitating workshops or hosting peer 

exchange circles. This builds a sense of community among facilitators and fosters 

collective learning, which is essential in a field where contexts and challenges are 

constantly evolving. 

 

6.4 Following Up with Youth: Beyond the 
Workshop 
Training young participants in media literacy, storytelling and anti-racist engagement does 

not end with the final workshop session. Sustainable impact requires thoughtful follow-up 

and continuous engagement. One effective approach is to help participants establish 

youth-led media clubs or storytelling collectives, where they can continue producing 

content and engaging in critical reflection. These clubs can operate informally in 

community centers or 

schools, or exist virtually 

through shared platforms. 

Follow-up strategies should 

also include opportunities for 

youth to present their work 

publicly. Whether through 

film screenings, digital 

exhibitions, podcast 

episodes or zines, 

showcasing youth creations 

helps validate their efforts 

and gives visibility to their 

perspectives. Such events 

not only boost confidence 

but also invite dialogue with 

broader audiences, including 

parents, educators, 
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policymakers and community leaders. 

Trainers can also encourage youth to become peer mentors. Participants who complete a 

training cycle may be invited to assist in future sessions, share their stories or help facilitate 

activities. This kind of youth-to-youth mentoring reinforces the multiplier effect and 

supports leadership development. 

Finally, feedback loops are essential. By implementing regular check-ins, surveys or 

reflection sessions, trainers can track the longer-term effects of training and adjust their 

approaches accordingly. This ongoing dialogue with participants ensures that training 

remains relevant, responsive and rooted in lived experience. 

 

6.5 Youth Workers as Agents of Democratic 
Resilience 
The work of youth workers extends far beyond facilitation. In the HATE-LESS framework, 

they are positioned as agents of democratic resilience - individuals who nurture critical 

literacy, amplify marginalized voices and support inclusive civic participation. This role 

connects directly to the goals of sustainability and the scaling-up of project impacts. 

To support this role, it is vital to view youth workers not just as trainers, but as community 

leaders, cultural translators and knowledge producers. They must be empowered to adapt 

the project’s tools to different linguistic, cultural and political contexts, while maintaining 

the integrity of its core values: anti-racism, empathy, participation and inclusion. 

Multiplying the project’s impact also requires youth workers to document and share their 

practices. Through reports, videos, blogs or workshops, they can contribute to a growing 

repository of case studies and best practices. This knowledge-sharing deepens the 

learning ecosystem and inspires new initiatives. 

In every stage - from training design to facilitation to follow-up - youth workers are key to 

transforming the guidelines into a movement. Their role is not static; it evolves with each 

workshop, each story and each young person they support. 

 

6.6 Conclusion: Learning as Legacy 
Facilitating training based on the HATE-LESS methodology is not merely a technical task 

- it is a commitment to building inclusive, democratic communities. By aligning conceptual 

guidance with practical tools, empowering youth workers as leaders and sustaining youth 

engagement over time, the project creates a training model that is reflective, creative and 

transformative. 

Youth workers are not only delivering content; they are enabling cultural shifts. They help 

young people move from being passive consumers of media to active creators of counter-

narratives. They foster spaces where critical dialogue is possible and where every voice 

count. And in doing so, they plant seeds of change that extend far beyond the training 

room. 

The invitation now is to carry these methods forward - with courage, care and a deep belief 

in the power of young people to shape the future. 
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